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Introduction

HUD’s Office of Native American Programs (ONAP) uses the Grants Evaluation and Management System
(GEMS) as its system of record for an ONAP grantee’s grant history and as the interface for processing and
managing ONAP grants. GEMS plays a substantial role in storing and analyzing data reported by grantees and
enabling ONAP staff to assess and report on grant performance.

The purpose of this Guide is to provide grantees with step-by-step instructions on how to use GEMS. The
instructions are accompanied by numerous screenshots.

Always rely on the current version of this Guide, as it provides the latest descriptions of GEMS and its
functionality. Check CodeTalk to make sure you have the latest version of the Guide and access recorded
trainings.
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. How to Register as a GEMS User

A Tribe/TDHE will determine who needs access to GEMS and what their permission level will be. There is no
limit on the number of users that your organization can have at this time. At a minimum, each Tribe and TDHE
must designate one Executive Contact, which is either the Tribal Chairperson, Tribal President, or the TDHE
Executive Director.

By registering, you agree that you have permission to create an account with the requested access level. All user
registration requests are reviewed and approved by ONAP; we will reach out to your organization to confirm
that access is being provided to the appropriate users.

1. Navigate your internet browser to the GEMS login page at https://hud.my.site.com/GEMS
a. We recommend you use Google Chrome. However, GEMS will work fully in most browsers.

2. Inthe top right-hand corner, click the red Log in button.

3. When the screen refreshes, click the Sign Up link in the lower right-hand corner.

GEMS

this page, you have to log in to HUD ONAP Grants

(J Remember me

Forgot Your Password?

US Govt- Department of Housing and Urban Development**
employee? Log In

4. On the next screen, read the Privacy Act Statement and select your ONAP region from the dropdown
menu. Click the Next button.

5. Complete the registration form. Additional information is provided below each field. All required fields
are indicated with an *:
e Tribe/TDHE: Start typing the name of your Tribe/TDHE and select it from the dropdown menu.
0 If you selected the wrong region on the last screen, scroll to the bottom of the form and
click the Previous button on the right-hand corner. Then return to Step 4.
o If you cannot find your organization, contact your area ONAP GEMS representative.
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e Salutation: Select your preferred salutation from the dropdown menu.

e First Name, Middle Name, Last Name, Suffix, Title, Telephone Number, Fax Number:
Enter your information in these fields.

e Primary Contact: Select Yes if you are the Executive Contact (the authorized entity) for the
Tribe/TDHE. Otherwise, select No.

e Registration Type: Select one of the following from the dropdown menu:

o New Account: Select if you have not previously used GEMS for your organization.

0 Reauthorization: Select if you need to update an existing or previously deactivated
GEMS account.

o0 Disablement: Select if you need to remove your GEMS account.

e Work Street, Work City, Work State/Province, Work Zip/Postal Code: Enter your
work/office address.

e Email: Enter your work email address. Note: If you are using general email (i.e.
housing.director@tribe.org), that was used by a previous user, you may need to contact the area
office before registering.

e Requested Access: Select the level of access you are authorized to have from the dropdown
menu. As shown in the image below, each level builds on and includes the previous one:

0 Read/Review Plans — allows you to only read forms.

o Create/Edit Plans — allows you to read, create, and edit forms.

o0 Sign/Submit Plans — allows you to read, create, edit, and submit forms; only select this
option if you have permission to sign and submit forms on behalf of your Tribe/TDHE.
= If your Tribe/TDHE allows it, you can have sign/submit plan access without being the

primary contact.

= The primary contact should always have sign/submit plan access.

Sign/
Submit
Plans

Create/
Edit
Plans

Read/
Review
Plans
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e Grant Program: Select the grant type(s) your organization has from the menu.

0 To select multiple grant types, hold down the Ctrl (PC) or Command (Mac) key while
clicking on the desired grant types. Repeat as needed. All the grant types you have selected
will show as highlighted with a gray background and white text.

o To remove one or more selected grant types, hold down the Ctrl (PC) or Command (Mac)
key and click on the grant type again that you want to remove from your selection. Repeat as
needed.

e Are you replacing someone in your tribe/housing entity?: Select Yes, No, or Unknown from
the dropdown menu.
o If you are unsure, select unknown.
e Comments: Add any additional comments to help ONAP review your request.

6. Click the Register button at the bottom right-hand corner. The system will automatically check to see if
you already have a GEMS account.

a. If you do not have an account in GEMS, you will receive an email that says your area ONAP
GEMS representative will review your registration request. Once the registration is approved,
you will receive an email with instructions on how to access the system. You may need to check
your email inbox and spam folder to find the email.

i. If you have not heard back about your registration within five (5) business days, please
reach out to your area ONAP office.

You have successfully submitted your registration to HUD. Your local area ONAP
representative will contact you regarding your registration.

b. If you have an account in GEMS, you will receive a message to reset your password. Click the
click here link and follow the steps to change your password. Your username is your email
address. (More information on resetting your password can be found in How to Create, Change,
or Reset Your Password.)

Note: If you are using general email i.e. housing.director@tribe.org, that was used by a pervious
user, you may need to contact the area office before registering.

The email address johnsGems@gmail.com you provided already exists in the Grants
Evaluation Management System (GEMS). Please click here to reset your password.

7. Once you complete the Registration, see the How to Submit the GEMS Signature Attestation Page
Section below. Please submit the signature attestation to the local ONAP office at the time of
registration.
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II. How to Submit the GEMS Signature Attestation Page

Please submit the signature attestation to the local ONAP office at the time of user registration.

As outlined in Notice PIH 2023-26, a one-time signature attestation is required for authorized officials to submit
electronic signatures in GEMS. The required form is the GEMS Signature Attestation.

GEMS is not connected to Secure Systems. As a result, we require users who are authorized to submit an IHP or
APR, and/or sign an Award Package, to sign the GEMS Authorization for Use Agreement or Signature
Attestation form.

By signing the GEMS Signature Attestation, the user attests to the following:

e Agreement to Terms: The signer agrees to the terms and conditions for using the HUD Grants
Evaluation Management System (GEMS).

e Accuracy and Compliance: The signer attests that all information submitted using their username is
accurate and complies with the relevant laws, regulations, and the instructions for all submitted
forms/documents.

e Electronic Signature (E-Signature): Entering the name in any signature section within GEMS serves as
the signer's electronic signature for submission. This E-Signature is legally bound and supported by the
attestation and wet signature, in accordance with the Federal E-Sign Act of 2000.

e User Responsibility: The signer is personally responsible for the security and use of their username and
password.

e Certification of Eligibility: The signer certifies that the information reflects activities actually planned or
accomplished during the stated periods, and that these activities are eligible under applicable statutes
and regulations.

e Warning of Penalties: The document contains a strict warning that knowingly making a false statement
may result in:

o Civil or criminal penalties under Section 1001 of Title 18 of the United States Code.
o A civil money penalty not exceeding $10,000 for each violation for knowingly and materially
violating any required information disclosure.
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[11. How to Create, Change, or Reset Your Password

Once your registration request is reviewed and approved by your area ONAP office, you will receive the email
shown below to set up a password. Your username is your email address; click the link in the email to set up

your password.

Sandbox: GEMS User Registration Request Accepted nbox x @&
HUD ONAP GEMS 11:48 AM (2 hours ag

tome v

Dear !

This email notifies you that your user registration request to access the account in the Grants Evaluation Management System (GEMS) was reviewed and accepted. To access your account please click on the following link to
set up your username and password: https.//stg-hudgrants ¢s32. force.com/login?c=Nb2tZzvPKRrLViz9.gcy IMJcr_W \Civ4 )yTMcXZ0ECMUmwrHnGlep78mjFwGzZN2 bD8YSVB8K KORC_2RbLUXOKRHaJe
OTGy.3P114DsNfoOLpVYWTMQ_C3tZXuvsA_zDBOEciuMJIrgCKWRpnFA4CpIQaWI0 3SFzw_SQyMJEGTeMC XKAOpWIGOH

To help you get started using GEMS please refer to the information in the following links

Link to User Guide —~ [Hopefully showing basic login through IHP/ARP submissions as well as printing, signatures, attaching documents etc. (Based on docs created by Metaphase)]

Link to FAQ's - [I forgot my password, Why can't | use IE? (Based on docs created by Metaphase)]

A password change can either be:
a) self-initiated while logged-in or
b) requested while logged-out, like when you cannot remember your password.

Self-Initiated Password Change While Logged-In

1. Click the person icon in the upper right-hand corner and click the Profile link from the dropdown.

2. Click the Settings & Preferences link from the menu on the right-hand side and click the Change
Password link down the screen on the left when the text changes.

Profile

My Settings

ACCOUNT DETAILS

Account

3. When the page refreshes, enter your current password as well as the new password you would like to

use. Please make sure that it has at least 10 characters, and includes at least one (1) letter, one (1)

number, and one (1) special character.
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Change My Password

You must adhere to the following password rules:

* Your password must be at least 10 characters leng.

* Your password must include letters and numbers

4. Once your password meets the requirements, click the Save button.

Password Change Request While Logged Out

If you need assistance resetting your password, please email ONAPGEMS@hud.gov.

1. Navigate your internet browser to the GEMS login page at https://hud.my.site.com/GEMS

2. Inthe top right-hand corner, click the red Log in button.

3. When the page refreshes, click the Forgot your Password? link in the lower left-hand corner.

.
GEMS

U5 Gaovi Depatment of Housng and Lirbas Deweinprment™
empioyes’ Log by

4. When the page refreshes, enter your username, and click the Continue button.

5. A password change request will be sent to your email address on file. When you receive the email, click
the included link. You may need to check your email inbox and spam folder to find the email. If you are
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unable to reset your password within 7 days of receiving the email, contact your area ONAP GEMS
representative to reset the password again as the link will have expired.

6. A webpage will open that asks you to create a new password. Please make sure that it has at least 10
characters, and includes at least one (1) letter, one (1) number, and one (1) special character.

7. Once your password meets the requirements, click the Change Password button to save the change.
8. If the Forgot your Password? link doesn’t work, please email ONAPGEMS@hud.gov, from your

registered email, with your full name, and an ONAP staff member can do a hard password reset. The
system will generate a new password reset link.
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V. How to Login to Your GEMS Account

If you do not have a GEMS account yet, please follow the steps in How to Register a User in GEMS.

1. Navigate your internet browser to the GEMS login page at https://hud.my.site.com/GEMS
a. We recommend you use Google Chrome. However, GEMS will work fully in most browsers.

2. Inthe top right-hand corner, click the red Log in button.

3. When the screen refreshes, enter your username (email address) and password.

GEMS

age, you have to log in to HUD ONAP Grants

—
[ Remember me

Forgot Your Password? Sign Up

US Govt- Department of Housing and Urban Development**
employee? Log In

4. Click the Log In button to go to the Home tab.
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V. How to Navigate the GEMS Grantee Portal

There are nine (9) tabs across the top of the portal. Starting on the left-hand side, additional information is
provided below about each tab. If there are less than nine (9) tabs across the top of your screen, the tab on the
right will say More, and the extra tabs can be found by clicking that tab.

1. The Home tab has a) a dashboard, where you can find upcoming deadlines and unfinished tasks, and b)
a calendar. If you think something listed has already been submitted and/or the due date appears wrong,
please contact your Grants Management Specialist or Grants Evaluation Specialist.

Home Organizations MNew Submissions

Dashboard Calendar

Upcoming Deadlines
HP for Grant Number FY2024 s past due for 25 days 17 hours 11 minutes
SF4235 for Grant

nber FY2023is past due for 12 days 17 hours 11 minutes

mb

APR for Grant Number FyZ0Z2 duein & days 7 hours 49 minutes

My Tasks

2. The Organizations tab shows which Tribe and/or TDHE your account is associated with and the Tribe

and TDHE hierarchy for these organizations. See How to View Your Organization’s Contacts for more
information.

Home Organizations NOFA New |

Accounts

My Organizations v #

2items = Sorted by Account Name » Filtered by All accounts - |s My Organizat
Account Name T “~ | Shipping Stree
1 HYTDHE 1212 Main Str

3. The NOFA tab is coming soon, and this section will be updated when it is available.

4. The New Submissions tab allows you to create new reports, requests, and documents. See How to
Complete an Initial IHP, How to Complete an IHP Waiver, How to Complete an Interim Fudging
Request, How to Complete an IHP Amendment, How to Complete an APR, and How to Update/Revise
an APR for more information.
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Organizations

New Submissions

Submissions

--Select-

--Select-

--Select-

--Select-

*Fiscal Year

*Grant Program

*Submission Type

*(1) Grant Number :

New Submission - Select a submission you wish to complete

Next Section

5. The Submissions tab shows the status of the submitted reports or documents for your organization. If no
decision is shown, your area ONAP office is still reviewing the submission. See How to Complete an
IHP Amendment, How to Complete an APR, How to Update/Revise an APR, How to Print an IHP/APR,

How to Update/Revise an SF-425, How to Print an SF-425 for more information.

Home

Version

Please select

Version v

1

1

Organizations

FY

2022

2023

2023

2023

2023

2019

2019

2020

2020

v

v

FY Submission Display Type
Please select v Please select

Submission Type v | Gr. v
SF425 Report (IHBG FormulaRead-...  IHBG
SF425 Report (IHBG Formula Read-... IHBG
SF425 Report (IHBG Formula Read-... IHBG
SF425 Report (IHBG Formula Read-... IHBG
SF425 Report (IHBG Formula Read-... IHBG
Initial Plan (IHP) IHBG
APR IHBG
IHP Waiver Request IHBG
Initial Plan (IHP) IHBG

New Submissions

Grant Program

Submissions

Grant Number

Compliance

Download Forms

Reporting Periond End Date Status

v Please select v Please select v

GrantNu... v

551H0222220

551H0222220

55IH0222220

551H0222220

55IH0222220

55IH0222220

551H0222220

551H0222220

551H0222220

Per.. v | Status

12/31/2...  Submitted

03/31/2... Submitted

06/30/2...  Submitted

09/30/2... Submitted

12/31/2...  Submitted

Submitted

Submitted

Submitted

Submitted

v

Decision v
Accepted

Accepted

In Compliance

Accepted

In Compliance

Please select

Submit... v | RecipientProgramYear v | Account... v
02/01/2023 1/1/2022-12/31/2022 Cedar Park T..
02/01/2023 1/1/2023- 12/31/2023 Cedar Park T...
02/01/2023 1/1/2023- 12/31/2023 Cedar Park T...
02/01/2023 1/1/2023- 12/31/2023 Cedar Park T...
02/02/2023 1/1/2023- 12/31/2023 Cedar Park T...
1/1/2019- 12/31/2019 Cedar Park T...
1/1/2019- 12/31/2019 Cedar Park T...
1/1/2020- 12/31/2020 Cedar Park T...
1/1/2020- 12/31/2020 Cedar Park T...

Recipient Reporting Year

v Please select v Please select

Re.. v

. 038564

038565

038566

038567

038568

FS-006...

FS-006...

FS-010...

FS-010...

6. The Awards tab lists the awards packages for your organization. See How to Sign Award Packages for
more information.

Home

Organizations

GCrantee Awards v ¥

New Submissions

Submissions Awards

1 item » Sorted by Package Name  Filtered by All packages - Record Type, Package Status » Updated a few seconds ago

Package Name 1

PK-000034

~ | Record Type ~ | Grant Number

Award 55IH0222220

v | FY

2019

v | Recipient

Cedar Park TDHE

Compliance

v | Grantee Tribe v

Download Forms

Search this ist...

Submission Type

Initial Plan (IHP)

% -

Vv | Review Decision

In Compliance

¢ ev
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7. The Compliance tab is coming soon, and this section will be updated when it is available.

8. The Cases tab allows you to submit a help ticket to your area ONAP office. See How to Submit and
Watch a Support Case for more information.

Organizations Mew Submissions Submissions Compliance “ase Download Forms

Cases o \
Printable View

My Cases v #

tems o Sorted by Case Mumber » Filtered by My cases » Updated a few seconds ago

Case Number 1 v | Contact Name ~ | Subject ~ | Status v | Priority “ | Date/Time Opened ~ | Case Owner Alias W

9. The Download Forms tab allows you to download a blank IHP/APR form, Tribal certification form,
and GEMS signature attestation page.

Organizations New Submissions Submissions Awards Compliance Download Forms

Please click a link below to download a form

For better result please download, save and open it in Internet Explorer.
Form HUD-52737 (IHP/APR)

Tribal Certification Form

GEMS Signature Attestation Page
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V1. How to Complete an Initial IHP

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click the New Submissions tab.

Home Organizations NOFA New Submissions Submissions

2. Select the following options from the dropdown menus:
e Grant Program: Select IHBG
e Submission Type: Select Initial Plan (IHP)
e Fiscal Year: Select the fiscal year for this IHP
e (1) Grant Number: Select the grant number for this IHP

* Grant Program

4ar

--Select--

* Submission Type

--Select--

4a»

* Fiscal Year

4»

--Select--

*(1) Grant Number:

4ar

--Select--

3. Click the Next Section button in the bottom right-hand corner to start the IHP.

4. The screen will refresh, and you will see Section 1: Cover Page. The section bar at the top shows your
progress and is color coded. It will be blue for the section you are working on, gray for a section that has
not been started yet, yellow for a section that was started but not completed, and green for a section that
is complete. All required fields are indicated with an *:

Section 3 Section 4 Section 5

IHBG PY 2022 ( 1/1/2022 - 12/31/2022 } Indian Housing Plan (IHP)

SECTION 1: COVER PAGE

5. You can complete the IHP in one setting or save your work and pick it up later. Each section will have
three (3) buttons in the bottom right-hand corner to a) go back to the last section (Previous Section), b)
save your work as a draft (Save as Draft), and ¢) go to the next section (Next Section).
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e To leave and return later, click Save as Draft, and find the IHP on the Home tab. Then click the

dropdown arrow at the end of the row and select Edit.

Previous Section Save as Draft Mext Section

6. Complete Section 1: Cover Page. Some information is prepopulated, and other information will

populate when the IHP is submitted; additional information is provided below about each field that you

can edit:

e (10) Contact Person: Enter the name of the contact person for the IHP.
e (11) Telephone Number: Enter the phone number of the contact person.
e (16) Fax Number: Enter the fax number of the contact person.

e (17) Email Address: Enter the email address of the contact person.

e (18) If TDHE, List Tribes Below: If you are with a TDHE, you will be able to check the box

for the Tribe you serve. (This field will not show when the grantee is the Tribe.)
e (21) CCR/SAM Expiration Date: Enter your organization’s CCR/SAM expiration date.

IHBG PY 2022 ( 1/1/2020 - 12/31/2020 ) Indian Housing Plan (IHP)
SECTION 1: COVER PAGE

*{1) Grant Mumber:

S35ITS167850

*{2) Recipient Program Year: i)

17172020 - 12/31/2020

*{3) Federal Fiscal Year: i
]

Submission Type

4} Initial Plan (Complete this Section then proceed to Saction
5} Amended Plan (Complate this Section and Section & if applicable)
Annual Performance Report (Complete items 27-30 and procesd to Section 3

Record Typs D

“{%) Mame of Recipient:
VWestern Testing Tribe
*{L0} Contact Person:

Mr Testworths

7. Click the Next Section button to go to Section 2: Housing Needs.
GEMS Grantee User Guide Version 1.22
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8. Complete Section 2 by selecting which types of need your organization will provide and typing in the
text boxes that are applicable. Descriptions for this section are included in GEMS.

SECTION 2: HOUSING NEEDS
NAHASDA § 102(b)(2)(B)

(1) Type of Need: Check the appropriate box(es) below to describe the estimated types of housing needs and the need for other assistance for low-income Indian families {(column B) and all Indian
families (column C) inside and outside the jurisdiction.

Check all that apply

Housing Needs

(A) Type of Need (B) Low-Income Indian Families (C) All Indian Families
(1) Overcrowded Househalds

(2) Renters Who Wish to Become Owners

(3) Substandard Units Needing Rehabilitation

(4) Homeless Households

(5) Households Needing Affordable Rental Units

(6) College Student Housing

(7) Disabled Households Needing Accessibility

(8) Units Needing Energy Efficiency Upgrades

(9) Infrastructure to Support Housing

(10) Other (specify below)

(2) Other Needs.

(Describe the other needs below. Note this text is optional for all needs except "Other.")

7
(3) Planned Program Benefits.
* (Describe below how your planned programs and activities will address the needs of low income families identified above. Also describe how your planned programs will address the various types of housing assistance needs NAHASDA § 102(b}(2)(B)):
Y
(4) Geographic Distribution.
* Describe below how the assistance will be distributed throughout the geographic area and how this geographic distribution is consistent with the needs of low income families. NAHASDA § 102(b)(2)(B)(i)):
7~

Previous Section Save as Dra| Next Section

9. Click the Next Section button to go to Section 3: Program Descriptions.

10. To complete Section 3, you will need to add each planned program individually by clicking the Add
New Program button.
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- Section 4 Section 5 Section 6 Section7 Section 8 Section 9 Attachments Review/Submit

IHBG PY 2021 (10/1/2021 - 9/30/2022 ) Indian Housing Plan (IHP)
SECTION 3: PROGRAM DESCRIPTIONS
[102(b)(2)(A)], [233(a)], [235(c)], [404(b)], 24 CFR §1000.512(b)(2) and (3)

In this section, the recipient must provide a description of its planned eligible activities, and intended outcomes and outputs for the One-Year IHP. The recipient can select any combination of
activities eligible under NAHASDA and intended outcomes and outputs that are based on local needs and priorities. There is no maximum or minimum number of eligible activities or intended
outcomes and outputs. Rather, the One-Year IHP should include a sufficient number of eligible activities and intended outcomes to fully describe any tasks that the recipient intends to fund in whole
or in part with IHBG resources during the coming program year.

Program Descriptions

Unigue Identifier

Add New Program

Vv | Program Name Vv | Eligible Activity Vv | Intended outcome number Vv | Actual outcome number v

Previous Section Save as Draft Next Section

11. The Add/Edit Program page will pop up. Fill in each field to describe the activity.

1.1a Unique Identifier: Any number you choose to identify the program by, but it is
recommended that you number them in order and include the program year, such as 2023-01.
The system will sort your programs by this field.
1.1b Program Name: A few words to summarize what the program is, such as Operation of
1937 Act Housing.
1.2 Program Description: Describe what specific types of projects will be developed during the
program year.
1.3 Eligible Activity Number: Select an activity from the dropdown that best fits the program.
1.4 Intended Outcome Number: Select an outcome from the dropdown that best fits the
program.
1.6 Who Will Be Assisted: Describe the types of households that will be assisted under the
program.
1.7 Types and Level of Assistance: Describe the types and level of assistance that will be
provided to each household.
Planned Number of Units to be Completed in Year Under this Program: Estimate the
number of IHBG-assisted units to be completed, households to be served, and/or acres to be
purchased for IHBG-assisted housing development for each planned activity during the program
year.
Prior and Current Year IHBG (only) funds to be expended in 12-month program year (L):
The cumulative amount of IHBG funds that are planned to be used for these activities in the
program year.
Total all other funds to be expended in 12-month program year (M): The amount of non-
IHBG funds that are planned to be used for these activities in the program year.
= Note: This field no longer breaks down by type of other funds. Just enter the total dollar
amount on this screen. You will need to break it out by funding source in Section 5.
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B Add/Edit Program

‘Add Program

* 1.1a Unique Identifier:

* 1.1bPr

ogram Name:

* 1.2.Program Description @

Uses of Funding

Prior and Current Year IHBG(only) funds to be expended in 12-month program year (L)

Total all other funds to be expended in 12-month program year (M)

Total funds to be expended in 12-month program year (N = L+M)

Describe the types and ssistance that will be

provided to each household, as applicable.

Cancel Save as Draft Save and Continue

12. Click the Save and Continue button to return to the main Section 3 page. Verify that each of the added
programs are displayed and fix any error messages that appear under the Add New Program button. If
you need to edit an activity, click the dropdown arrow at the end of the row that you need to edit, and
select Edit to reopen the Add/Edit Program page.

Unique Identifier ~ Program Mame N Eligible Activity ~ Intended outcome number

2022-001 Burrowed Bengal Rentals {4) Construction of Rental Housing [202{2)] (7} Create new affordable rental units
2022-003 Brady Apts Rehab |5) Rehabilitation of Rental Housing [202(... (3} Improve guality of substandard unitd
2021-003 Allentown Semi-Luxury Homes {11} MNew Construction of Homebuyer Uni... (2} Assist renters to become homeowne

Add

Please correct data for program{s): Burrowed Bengal Rentals,Brady Apts Rehab Allentown Semi-Luxury Homes

Program Descriptions

MNewr Program

13. Repeat Steps 10, 11, and 12 until you have entered all the programs that need be included in this IHP.

If an activity is close to one you have already created for this IHP, you can copy it by clicking
the dropdown arrow at the end of the row and select Clone to open the Add/Edit Program page.
If an activity is entered in error, you can delete it by clicking the dropdown arrow at the end of
the row and select Delete.

14. Click the Next Section button to go to Section 4: Maintaining 1937 Act Units, Demolition, and
Disposition.

15. Complete Section 4 by typing in the text boxes. Descriptions for this section are included in GEMS.
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- Section 5 Section 6 Section7 Section 8 Section 9 Attachments Review/Submit

IHBG PY 2020 ( 10/1/2021 - 9/30/2022 ) Indian Housing Plan (IHP)

SECTION 4: MAINTAINING 1937 ACT UNITS, DEMOLITION, AND DISPOSITION
NAHASDA §§ 102(b)(2)(A)(v), 102(b)(2)(A)(iv)(I-111)
(1) Maintaining 1937 Act Units

* (NAHASDA § 102(b)(2)(A)(v)) (Describe specifically how you will maintain and operate your 1937 Act housing units inorder to ensure that these units will remain viable.) :

(2) Demolition and Disposition

* (NAHASDA § 102(b)(2)(A)(iv)(I-111), 24 CFR 1000.134) Describe any planned demolition or sale of 1937 Act or NAHASDA-assisted housing units. If the recipient is planning on demolition or disposition of 1937 Act or NAHASDA-assisted housing units, be
certain to include the timetable for any planned demolition or disposition and any other information that is required by HUD with respect to the demolition or disposition.

Z

Previous Section Save as Draft Next Section

16. Click the Next Section button to go to Section 5: Budgets.

17. Complete Section 5 by updating the three components as follows:

e Inthe (1) Sources of Funding table, enter dollar amounts in Columns A, B, and D to report the
actual funds available for each source. The system will calculate Columns C and E in real time;
they will be $0.00 until information is entered in Columns A, B, and D.

SECTION 5: BUDGETS
NAHASDA §§ 102(b)(2)(C), 404(b)

(1) Sources of Funding (NAHASDA § 102(b)(2)(C)(i), (404(b)) (Complete the non-shaded portions of the chart below to describe your estimated or anticipated sources of funding for the 12-month program year. APR Actual

Sources of Funding -- Please complete the shaded portions of the chart below to describe your actual funds received. Only report on funds actually received and under a grant agreement or other binding commitment
during the 12-month program year.)

(A (B) © (D) E)
Source Estimated amount on hand at Estimated amount to be received during Estimated total sources  Estimated funds to be expended during Estimated unexpended funds remaining at
beginning of program year 12-month program year of funds (A+B) 12- month program year end of program year (C-D)
1. IHEG Funds $0.00 $0.00
2. 1HEG Program
o8 $0.00 $0.00

Income
3. Title VI $0.00 $0.00
4. Title VI Program

' rosran $0.00 $0.00
Income:

5.1937 Act Operating 20,00 $0.00

Reserves

6. Carry Over 1937 Act $0.00 $0.00
soc 20.¢

Funds

7.1CDBG Funds

50,00 $0.00
8. Other Federal Funds 50,00 $0.00
9. LIHTC $0.00 $0.00
10. Non-Federal Funds $0.00 $0.00
Total $0.00 $0.00

TOT. Columns nd
OTAL Columns C ar 5000
H( 2 through 10

e Inthe (2) Uses of Funding table, check the information in Columns L and M for each of your
programs. These dollar amounts will auto-populate from Section 3. If you fix any of these cells,
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it will automatically update Section 3 as well. The system will calculate Column N in real time;
it will be $0.00 until information is entered in Columns L and M.
0 GEMS might not show your programs in the order you expect, so check the program
name before entering any figures.

(L (M) (N)
PROGRAM NAME Prior and current year IHBG Total all other funds to be Total funds to be
(only) funds to be expended in | expended in 12-month expended in 12-month
12-month program year program year program year (L+M)
2024-1: Continue to operate
and maintain our current [ $1,665,836.00 ] [ $0.00 ] $1,665,836.00
assisted stock.
2024-2: Modernization of
1937 Act Housing [ $190,290.00 ] [ $0.00 ] $190,290.00
2024-3: Provide housing [ $19,000.00 ] [ $74,250.00 ] $93,250.00
services to eligible families.
Planning and Administration [ $416,000.00 ] [ $0.00 ] $416,000.00
Loan repayment - describe in [ ] [ ]
3 & 4 below $0.00 $0.00 $0.00
TOTAL $2,291,126.00 £74,250.00 $2,365,376.00

e Inthe (3) Estimated Sources of Uses of Funding (NAHASDA § 102(b)(2)(C)) text box, type in
any applicable information. A description for this text is included in GEMS.

18. Click the Next Section button to go to Section 6: Other Submission Items.

19. Complete Section 6 by typing in the text boxes and selecting yes/no on the relevant questions.
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Section 6: Help

IHBG PY 2020 (10/1/2021 - 9/30/2022 ) Indian Housing Plan (IHP)

SECTION 6: OTHER SUBMISSION ITEMS
[102(b)(2)(C)(ii)}, [201(b)(5)], [202(6)], [205(a)(2)], [209), 24 CFR §§ 1000.108, 1000.120, 1000.142,

1000.238, 1000.302

* (1) Useful Life/Affordability Period(s) (NAHASDA § 205, 24 CFR § 1000.142) (Describe your plan or system for determining the useful life/affordability period of the housing it assists with IHBG and/or Title VI funds must be provided in the IHP. A record of
the current, specific useful life/affordability period for housing units assisted with IHBG and/or Title VI funds (excluding Mutual Help) must be maintained in the recipient’s files and available for review for the useful life/affordability period.):

Z

*(2) Model Housing and Over-Income Activities (NAHASDA § 202(6), 24 CFR § 1000.108) (If you wish to undertake a model housing activity or wish to serve non-low-income households during the 12-month program year, those activities may be described

here, in the program description section of the 1-year plan, or as a separate submission.):
Z

(3) Tribal and Other Indian Preference (NAHASDA § 201(b)(5), 24 CFR § 1000.120) If preference will be given to tribal members or other Indian families, the preference policy must be described. This information may be provided here or in the
program description section of the 1-year plan.

* Does the Tribe have a preference policy?

[ Yes [ No
Complete this field.
(4) Anticipated Planning and Administration Expenses (NAHASDA § 102(b)(2)(C)(ii), 24 CFR § 1000.238)

Do you intend to exceed your allowable spending cap for Planning and Administration?

Yes No
* (6) Expanded Formula Area - Verification of Substantial Housing Services (24 CFR § 1000.302(3)) If your tribe has an expanded formula area (i.e., an area that was justified based on housing services provided rather than the list of areas defined in 24 CFR §
1000.302 Formula Area (1)), the tribe must. thatitis inui P ial housing services to that expanded formula area. Does the tribe have an expanded formula area?
[ Yes [ No

Complete this field
If yes, list each separate geographic area that has been added to the Tribe's formula area and the documented number of Tribal members residing there.

For each separate formula area expansion, list the budgeted amount of IHBG and other funds to be provided to all American Indian and Alaska Native (AIAN) households and to only those AIAN households with incomes 80% of

Previous Section Save as Draft Next Section

median income or lower during the recipient’s 12-month program year.

20. If your organization has expanded its formula area, answer yes in Line 6 to add this information. If not,
answer no and skip to Step 23.

21. Click the Add Expanded Formula Area button to add the fields you need to complete and add the

necessary data. All the fields are required; they are:

Geographic area that has been added to the Tribe’s formula area and the documented number of
Tribal members residing there

e All AIAN Households — IHBG Funds

¢ AIAN Households with Incomes 80% or Less of Median Income — IHBG Funds

e All AIAN Households — Funds from Other Sources

AIAN Households with Incomes 80% or Less of Median Income — Funds from Other Sources

*(6) Expanded Formula Area - Verification of Substantial Housing Services (24 CFR § 1000.302(3)) If your tribe has an expanded formula area (i.e., an area that was justified based on hous-
ing services provided rather than the list of areas defined in 24 CFR § 1000.302 Formula Area (1)), the tribe must demonstrate that it is continuing to provide substantial housing services to

that expanded formula area. Does the tribe have an expanded formula area?
v Yes No
If yes, list each separate geographic area that has been added to the Tribe's formula area and the documented number of Tribal members residing there.

For each separate formula area expansion, list the budgeted amount of IHBG and other funds to be provided to all American Indian and Alaska Native (AIAN)
households and to only those AIAN households with incomes 80% of median income or lower during the recipient’s 12-month programyear.

Add Expanded Formula Area
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Expanded Formula Area

* Geographic area that has been added to the Tribe’s formula area and the documented number of Tribal members residing there

* All AIAN Households - IHBG Funds

* AIAN Households with Incomes 80% or Less of Median Income - IHBG Funds

* All AIAN Households - Funds from Other Sources

* AIAN Households with Incomes 80% or Less of Median Income - Funds from Other
Sources

22. Repeat Step 21 until you have entered all the expanded formula areas that need be included in this IHP.
e If you click the Add Expanded Formula Area button too many times, click the garbage can
icon for any expanded area that needs to be removed.

23. Click the Next Section button to go to Section 7: Indian Housing Plan Certification of Compliance.

24. Complete Section 7 by selecting yes, no, or not applicable on the six (6) questions. Descriptions for this
section are included in GEMS.
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IHBG PY 2020 ( 10/1/2021 - 9/30/2022) Indian Housing Plan (IHP)

SECTION 7: INDIAN HOUSING PLAN CERTIFICATION OF COMPLIANCE

NAHASDA § 102(b)(2)(D)

By signing the IHP, the recipient certifies its compliance with Title Il of the Civil Rights Act of 1968 (25 USC Part 1301 et seq.), and ensures that the recipient has all appropriate policies and procedures in place to operate its
planned programs. The recipient should not assert that it has the appropriate policies and procedures in place if these documents do not exist in its files, as this will be one of the items verified during any HUD monitoring review.

(1) In accordance with applicable statutes, the recipient certifies that:

* It will comply with Title Il of the Civil Rights Act of 1968 in carrying out this Act, to the extent that such title is applicable, and other applicable federal statutes.
QO VYes

O No

Complete this field.

(2) In accordance with 24 CFR 1000.328, the recipient receiving less than $200,000 under FCAS certifies that:

* There are households within s jurisdiction at or below 80 percent of median income
QO VYes

QO No

O Not Applicable

Complete this field.

(3) The following certifications will only apply where applicable based on program activities.

* a. It will maintain adequate insurance coverage for housing units that are owned and operated or assisted with grant amounts provided under NAHASDA, in i with such i s may b It by HUD;
QO VYes

QO No

O Not Applicable

Complete this field.

* b. Policies are in effect and are available for review by HUD and the public governing the eligibility, admission, and occupancy of families for housing assisted with grant amounts provided under NAHASDA;

QO Yes
O No
O Not Applicable
Complete this field.

* . Policies are in effect and are available for review by HUD and the public governing rents charged, including the methods by which such rents or homebuyer payments are determined, for housing assisted with grant amounts provided under NAHASDA;
and

QO Yes
QO No
(O Not Applicable
Complete this field.

*d. Policies are in effect and are available for review by HUD and the public governing the management and maintenance of housing assisted with grant amounts provided under NAHASDA
QO VYes

QO No

O Not Applicable

Complete this field.

Previous Section Save as Draft Next Section

25. If you are with a TDHE, click the Next Section button to go to Section 8: IHP Tribal Certification. If
you are with a Tribe, skip to Step 27.

26. Complete Section 8 by selecting how the tribal government reviews the IHP and providing the Tribe’s
name, as well as the authorized official’s name and title. Wet signatures may be added on the
Attachments Section.

IHBG PY 2020 ( 10/1/2021 - 9/30/2022) Indian Housing Plan (IHP)

SECTION 8: IHP TRIBAL CERTIFICATION

NAHASDA § 102(c)

This certification is used when a Tribally Designated Housing Entity (TDHE) prepares the IHP or IHP amendment on behalf of a tribe.
This certification must be executed by the recognized tribal government covered under the IHP.

(1) Ther ized tribal g of the grant iary certifies that:

(2) It had an opportunity to review the IHP or IHP amendment and has authorized the submission of the IHP by the TDHE; or

(3) It has delegated to such TDHE the authority to submit an IHP or IHP amendment on behalf of the Tribe without prior review by the Tribe.
(4) Tribe:
(5) Authorized Official’s Name and Title:

(6) Authorized Official’s Signature (Enter your name to sign electronically.):

(7) Date (MM/DD/YYYY):
Jan 4,2022

Previous Section Save as Draft
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27. Click the Next Section button to go to Section 9: Tribal Wage Certification.

28. Complete Section 9 by selecting how your organization will determine wages. A text box is included if
more information needs to be included.

IHBG PY 2020 ( 10/1/2021 - 9/30/2022) Indian Housing Plan (IHP)
SECTION 9: TRIBAL WAGE CERTIFICATION
NAHASDA §§ 102(b)(2)(D)(vi), 104(b)

* By signing the IHP, you certify whether you will use tribally determined wages, Davis-Bacon wages, or HUD determined wages. Check only the applicable box below.

QO (1) Youwill use tribally determined wage rates when required for IHBG-assisted construction or maintenance activities. The Tribe has appropriate laws and regulations in place in order for it to determine and distribute prevailing wages.
O (2) You will use Davis-Bacon or HUD determined wage rates when required for IHBG-assisted construction or maintenance activities.

QO (3) You will use Davis-Bacon and/or HUD determined wage rates when required for IHBG-assisted construction except for the activities described below.

Complete this field.

(4) If you checked the box in Line 3, list the other activities that will be using tribally determined wage rates:

4

Previous Section Save as Draft Next Section

29. Click the Next Section button to go to Attachments Section.

30. Complete this section by uploading any attachments that need to be added to your IHP. Click the
dropdown menu below Select a Document Type to attach to the form on the right-hand side of the
screen. The options are GEMS Signature Attestation Page, Tribal Certification Signature Page,
Delegation of Authority, Tribal Resolution, and Other. (Note: Forms requiring signatures can be found
under the Download Forms tab.)

o Please upload files individually. Your Grants Management Specialist will verify that all sections
are complete and properly attached before moving your IHP to the next stage of the review
process.

e The GEMS Signature Attestation Page only needs to be completed once per person.

IHBG PY 2022 ( 1/1/2022 - 12/31/2022) IHP
Attachments

* Select a Document Type to attach to the form
B Attachment(1) N

Please select...

Please select...

Cedar - GEMS Signature Attenstation GEMS Signature Attestation Page
May 10, 2024 « 628KB «

File Type: PDF Tribal Certification Signature Page

Title: Cedar - GEMS Signature Attenstation Delegation of Authority
Type: GEMS Signature Attestation Page

[«
B

Tribal Reselution
Other

ViewAll

Previous Section Save as Draft

31. When you have selected the document type, you will have the option to find where the file is saved on
your computer (the Upload Files button) or drag and drop the file from a location that you can see.
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32. Ensure the file’s title and type are correct, and verify that your attachment was successfully uploaded.

Screen Shot 2021-03-18 at 5.49.46 PM
Mar 18,2021 o 53KB o
File Type: PNG
" Title: Screen Shot 2021-03-18 at 5.49.46 PM
Type: GEMS Signature Page

33. Repeat Steps 30, 31, and 32 until all files are attached.
34. Click the Next Section button to go to the Review/Submit Confirmation section.

35. If the IHP is complete, the section bar will be green and there will be a checkbox next to each of the
sections under Section Completion Status. Revisit any section that is not yet complete.

G 7 N T S T T ) R e N
IHBG PY 2020 (10/1/2021 - 9/30/2022) Indian Housing Plan (IHP)

Review / Submit Confirmation

Section Completion Status
Section 1

<

Section 2
Section 3
Section 4
Section 5
Section 6

JEREEREEE

Section7
Section 8

<

Section 9

Certification: The information contained in this document is accurate and reflects the activities actually planned or accomplished during the program year. Activities planned and accomplished are eligible under applicable statutes and
regulations.

Warning: If you knowingly make a false statement on this form, you may be subject to civil or criminal penalties under Section 1001 of Title 18 of the United States Code. In addition, any person who knowingly and materially violates any
required disclosure of information, including intentional disclosure, is subject to a civil money penalty not to exceed $10,000 for each violation.

*Name of Authorized IHP Submitter

*Title of Authorized IHP Submitter Please fill out this field.

*Signature of Authorized IHP Submitter (Enter your name to sign electronically)

Electronically signed by

* IHP Submission Date

1/4/2022

Previous Section Save as Draft

36. Once complete, your IHP is ready to submit. As someone authorized to submit it, type your name twice
and then your title. Click the Submit button. You will receive a message that says your IHP has been
submitted and is pending approval; you may wish to print this page for your records.
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Organizations New Requests Submissions Awards Compliance Download HUD Forms

Congratulations! Your Indian Housing Plan (IHP) has been submitted to HUD but it is pending the appropriate Approving Official's wet signature(s). Please ensure the
Approving Official wet signature(s) is sent to HUD as soon as possible.

37. Click the Close button to return to the Home tab.

38. You can check the status of your IHP from the Submissions tab. If no decision is shown, your area
ONAP office is still reviewing your submission.

Organizations New Submissions Submissions Compliance Download Forms
Version FY Submission Display Type Grant Program Grant Number Reporting Periond End Date Status Recipient Reporting Year
Please select v Please select v Please select v Please select v Please select v Please select v Please select v Please select v
Version v | FY s~ | SubmissionType v | G.. v | GrantN.. ~ | PeriodE... v | Status Submi... ~ | Recipient ProgramYe... v | Account... 1 v
1 2022 SF425 Report (IHBG...  IHBG 55IH0222220  12/31/2022 Submitted 02/01/2023  1/1/2022 - 12/31/2022 Cedar Park TDHE
1 2023 SF425Report (IHBG...  IHBG 55IH0222220  03/31/2023 Submitted 02/01/2023  1/1/2023-12/31/2023 Cedar Park TDHE
1 2023 SF425Report (IHBG...  IHBG 55IH0222220  06/30/2023 Submitted 02/01/2023  1/1/2023-12/31/2023 Cedar Park TDHE
1 2023 SF425 Report (IHBG... IHBG 55IH0222220  09/30/2023 Submitted 02/01/2023  1/1/2023-12/31/2023 Cedar Park TDHE
1 2023 SF425 Report (IHBG...  IHBG 55IH0222220  12/31/2023 Submitted 02/02/2023  1/1/2023-12/31/2023 Cedar Park TDHE
2019 Initial Plan (IHP) IHBG 551H0222220 Submitted In Compliance 1/1/2019 - 12/31/2019 Cedar Park TDHE
2019 APR IHBG 55IH0222220 Submitted 1/1/2019 - 12/31/2019 Cedar Park TDHE
2020 IHP Waiver Request IHBG 55IH0222220 Submitted 1/1/2020- 12/31/2020 Cedar Park TDHE

39. If you need to print your IHP, see How to Print an IHP/APR.
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VIl.How to Complete an IHP Waiver

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click the New Submissions tab.

Home Organizations NOFA New Submissions Submissions

2. Select the following options from the dropdown menus:

Grant Program: Select IHBG

Submission Type: Select IHP Waiver Request

Fiscal Year: Select the fiscal year for this waiver

(1) Grant Number: Select the grant number for this waiver

* Grant Program

--Select-- v

* Submission Type

--Select-- v

* Fiscal Year

--Select--

*(1) Grant Number :

--Select--

3. Click the Next Section button in the bottom right-hand corner to start the IHP waiver request.

4. Complete the request form. Descriptions for this section are included in GEMS, and all required fields
are indicated with an *.
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SECTION 15: IHP WAIVER REQUESTS
NAHASDA § 101(b)(2)

THIS SECTION IS ONLY REQUIRED IF THE RECIPIENT IS REQUESTING A WAIVER OF AN IHP SECTION OR A WAIVER OF THE IHP SUBMISSION DUE DATE.

Awaiver is valid for a period not to exceed 90 days Fill out the form below if you are requesting a waiver of one or more sections of the IHP. NOTE : This is NOT a waiver of the IHBG program requirements but rather a request to
waive some of the IHP submission items.
*(1a) Type of Waiver Request
Extend IHP Due Date
IHP Section Waiver

(1b.) Select the sections of the IHP where you are requesting a waiver and/or a waiver of the IHP due date.
1. Cover Page

2. Housing Needs
3. Program Descriptions

4. Maintaining 1937 Act Units, Demolition, and Disposition
5.Budgets

6. Other Submission Items

7.Indian Housing Plan Certification of compliance

8.1HP Tribal Certification

9. Tribal Wage Rate Certification

*(2) Describe the reasons that you are requesting this waiver ( Describe completely why you are unable to complete a particular section of the IHP or could not submit the IHP by the required due date.):

A
*(3) Describe the actions you will take in order to ensure that you are able to submit a complete IHP in the future and/or submit the IHP by the required due date. ( This section should completely describe the procedural, staffing or technical corrections
that you will make in order to submit a complete IHP in the future and/or submit the IHP by the required due date.):

Y
*(4) Recipient :
HYTDHE

*(5) Authorized Official's Name and Title :
* (6) Authorized Official's Signature (Enter your name to sign electronically.)

(7) Date(MM/DD/YYYY) :

Jan 13,2022

5. Click the Submit button. You will receive a message that says your request has been submitted and is
pending approval; you may wish to print this page for your records.

Congratulations, your IHBG FY 2021 ( 10/1/2021 - 9/30/2022 ) IHP Waiver Request for HYTDHE : 55-IT-12345 was submitted to HUD successfully and is under review.

Close

6. Click the Close button to return to the Home tab.

7. You can check the status of your IHP waiver request from the Submissions tab. If no decision is shown,
your area ONAP office is still reviewing your submission.
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Organizations New Submissions Submissions Awards

Version FY Submission Display Grant Program Grant Number Reporting Periond End Status
Type Date
Please select w 2020 = v Please select w Pleaseselect w Please select
Please select w Please select v

Version v | FY v | Submission Type v | G. v | GrantNu.. v | Peri.. v | Status v | Decision w

2020 IHP Waiver Request IHBG 55|H0222220 Submitted
2020 Initial Plan (IHP) IHBG  551H0222220 Submitted In Compliance
2020 APR IHBG  55IH0222220 Submitted

8. If you need to print your IHP waiver, see How to Print an IHP/APR.
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VIII. How to Complete an Interim Funding Request

To submit an interim funding request, your organization must have:
e Previously submitted an IHP for the Fiscal Year that was found in compliance.
o If the IHP has been submitted but is not listed as being in compliance, please contact your Grants
Management Specialist.
e Received a notification that the funds are available for this grant.

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click the New Submissions tab.

Organizations New Submissions Submissions

2. Select the following from the dropdown menus:

Grant Program: Select IHBG

Submission Type: Select Interim Funding Request
Fiscal Year: Select the fiscal year for this request

(1) Grant Number: Select the grant number for this request

* Grant Program

IHBG .

* Submission Type

Interim Funding Request

*Fiscal Year

2022 .

*(1) Grant Number :
55IT5167890 -

3. Click the Next Section button in the bottom right-hand corner to start the interim funding request.
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Interim Funding Request

Mame of Recipient : HYTDHE

Grant Number : 55-1T-12345

Fiscal Year: 2021

Program Year : 10/1/2021 - 9/30/2022
Grant Program : IHBG

*Requested Interim Funding Amount

* Describe the reasons why you are requesting Interim Funding

* Recipient

HYTDHE
* Authorized Official’s Name and Title

* Authorized Officlal’s Signature

Date (MM/DDAYYYY)

Jan 18,2022

Cancel Save as Draft

4. Complete the request form. All required fields are indicated with an *:

e Requested Interim Funding Amount: Enter the amount you are requesting with this request

(the maximum amount is set forth in the HUD notice).

e Describe the reason why you are requesting Interim Funding: Outline why you are

requesting interim funding.
e Contact Person: Enter the name of the contact person for the request.
e Telephone Number: Enter the phone number of the contact person.
e Email Address: Enter the email address of the contact person.

e Authorized Official’s Name and Title: As someone authorized to submit this request, enter

your name and title.

e Authorized Official’s Signature: As someone authorized to submit this request, type your

name.

5. Click the Submit button. You will receive a message that says your interim funding request has been

submitted and it is pending approval; you may wish to print this page for your records.

Congratulations, your IHBG FY 2021 ( 10/1/2021 - 9/30/2022 ) Interim Funding Request for HYTDHE : 55-1T-12345 was submitted to HUD successfully and is under review.

6. Click the Close button to return to the Home tab.

7. You can check the status of your request from the Submissions tab. If no decision is shown, your area

ONAP office is still reviewing your submission.
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IX. How to Sign Award Packages

To sign an award package, your organization must meet the following requirements:
e For IHBG, you must have previously submitted an IHP for the fiscal year that was found to be in
compliance.
o If the IHP has been submitted but is not yet listed as compliant, please contact your Grants
Management Specialist.
e For other grant programs such as ICDBG, Tribal HUD-VASH, or IHBG-Competitive, there must have
been a published notice of award.
e You must have received an email notification stating that you can log in to sign your grant agreement.
e The authorized representative with signature privileges must be logged into the system.
0 Note: The Authorized Official must sign the Grant Agreement from their own account in GEMS.
If the Authorized Official does not have a GEMS account, they can register for GEMS, or they
may print and sign the Grant Agreement manually and return it to the area ONAP office.
o If the Authorized Official has delegated authority, you must send in a written copy of the
delegation of authority to the area office.

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click the Home tab.

2. Look under My Tasks for “Grant Agreement” under Submission Type column. Click the Dropdown
Arrow at the end of the row for the Grant Agreement that you need to sign and click Edit.

My Tasks Reset Filters Create New Submission
Displ Grant Prog Grant N Reporting P d Due Date t [2 D
lease se lect v Please sel lect v Pleas ct v ICDBG v lease se lect v Please se lect v Please select v Pl t v | | v
Version » | FY » | SubmissionType ~ | Gra.. » | GrantNumber > | PeriodEn.. » | DueDate ~ | Status ~ | Recipient Program Year » | Account.. * | Report# v
1 2025 SF425 Report ICDBG 23GC0000200 03/31/2026 06/29/2026 Not Started 47172026 - 3/31/2026 Austin Tribe 022854
1 2025 SF425 Report ICDBG 22GC0000200 03/31/2026 06/29/2026 Not Started 4/1/2026 - 3/31/2026 Austin Tribe 022856
1 2025 SF425 Report ICDBG 21GC0000200 03/31/2026 06/29/2026 Not Started 4/1/2026 - 3/31/2026 Austin Tribe 022858
1 2025 SF425 Report ICDBG 26GC0000200 03/31/2026 06/29/2026 Not Started 4/1/2026 - 3/31/2026 Austin Tribe 023568
2023 Grant Agreement ICDBG 23GC0000200 Pending Grantee Signature Austin Tribe PK-002998 o

3. On the Sign/Submit Award Agreement page, enter the required information and click Submit.
e Review Award Documents: Click the links below to review the following:
o HUD-52734
0 Award Letter
e Authorized Official’s Name: GEMS will automatically populate this field based on your system
profile.
e Authorized Official’s Title: GEMS will automatically populate this field; however, it can be
edited if necessary.
e Authorized Official’s Signature: Type your name to certify that you are authorized to submit
this request.
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Sign/Submit Award Agreement

Name of Recipient : Austin Tribe
Grant Number : 551H0000201

Fiscal Year: 2024

Program Year: 4/1/2024 - 3/31/2025
Grant Program: IHEG

Package ID : PK-003001

Documents:

HUD-52734-B

IHBG Award Letter

* Authorized Official’s Name

Owen Strand

* Authorized Official’s Title

Tribal Leader

* Authorized Official's Signature @

@

Complete this field

Date

Apr2,2026

copy onfile.

If the Authorized Official cannot sign the grant agreement (HUD-52734-B) in GEMS from their own account, the Tribe or TDHE may print, sign, date, scan, and email the document to their Grants Management Specialist. Please keep the original

Cance! Submit

4. Click on the Letters/Awards tab. When the screen refreshes, click on the link under the Package

Number column to open the grant agreement.

Award Packages

Displaying 1-5 of 5 items

Package Id 4 Name
PK-003034 Award
PK-003033 Award
PK-003001 Award
PK-002999 Award
PK-002998 Award

Grant Number

21GC0000200

22GC0000200

551H0000201

24GC0000201

23GC0000200

FY

2021

2022

2024

2024

2023

Grantee Tribe

Submission Type

ICOBG Grant

ICOBG Grant

Initial Plan (IHP)

ICDBG-IT Grant

ICDBG Grant

5. Click the red PDF icon in the View column next to each document to open and review it, and save a

copy for the grantees records.

Generated Packages

Displaying 1-2 of 2 items
Document Name 1

HUD-52734

ICDBG Award Letter

View
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X. How to Amend Your IHP

To complete an IHP Amendment, your organization must have:
e Previously submitted an IHP for the Fiscal Year that was found in compliance.
o If the IHP needs to be submitted, see How to Complete an Initial IHP. When the IHP is found to
be compliant, you can return to complete the amendment process.
o0 If the IHP has been submitted but the status is not “in compliance”, please contact your Grants
Management Specialist.

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click the New Submissions tab.

Organizations New Submissions Submissions

2. Select the following options from the dropdown menus:
e Grant Program: Select IHBG
e Submission Type: Select Amended Plan
e Fiscal Year: Select the fiscal year for this request
e (1) Grant Number: Select the grant number for this request

New Submission - Select a submission you wish to complete

3. Click the Next Section button in the bottom right-hand corner. The IHP that you are amending will be
copied, and you will be able to make any necessary changes. While you do not need to make changes in
each section, you need to click through each section for the system to determine if the page is complete.

4. From this point, the instructions are the same as submitting the initial IHP. Please see How to Complete
an Initial IHP and start with Step 4.
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XI1. How to Complete an APR

To complete an APR, you organization must have previously submitted an IHP for the Fiscal Year that was
found in compliance.
o0 If the IHP needs to be submitted, see How to Complete an Initial IHP. When the IHP is found to
be compliant, you can return to complete the APR submission process.
o0 If the IHP has been submitted but the status is not ‘In Compliance’, please contact your Grants
Management Specialist.

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click the New Submissions tab.

Organizations New Submissions Submissions

2. Select the following options from the dropdown menus:
e Grant Program: Select IHBG
e Submission Type: Select Annual Performance Report
e Fiscal Year: Select the fiscal year for this report
e (1) Grant Number: Select the grant number for this report

*Grant Program

ar

--Select--

*Submission Type

ar

--Select--

*Fiscal Year

ar

--Select--

*(1) Grant Number :

ar

--Select--

3. Click the Next Section button in the bottom right-hand corner to start the APR.

4. The screen will refresh, and you will see Section 1: Cover Page. The section bar at the top shows your
progress and is color coded. It will be blue for the section you are working on, gray for a section that has
not been started yet, yellow for a section that was started but not completed, and green for a section that
is complete. All required fields are indicated with an *.
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Section 3 Section 6 Section 10 S

IHBG PY 2022 (1/1/2022 - 12/31/2022 ) Annual Performance Report (APR)

SECTION 5: BUDGETS
NAHASDA §§ 102(b)(2)(C). 404(b)

5. You can complete the APR in one sitting or save your work and pick it up later. Each section will have
three (3) buttons in the bottom right-hand corner to a) go back to the last section (Previous Section), b)
save your work as a draft (Save as Draft), and ¢) go to the next section (Next Section).

To leave and return later, click Save as Draft, and find the APR on the Home tab. Then click the
dropdown arrow at the end of the row and select Edit.

Previous Section Save as Draft Mext Section

6. Check all fields in Section 1 to make sure the contact information for the report and the CCR/SAM
expiration date are correct, as this information could have changed during the year. Update the fields, as
needed.

7. Click the Next Section button at the bottom of the screen to move to Section 3: Program Descriptions.
8. Complete Section 3 by opening each program from your IHP. Click the dropdown arrow at the end of

the row and select Edit to open the Add/Edit Program page. GEMS might not show your programs in
the order you expect, so check the program name before entering any information.

- Section 4 Section 5 Section & Section 7 Section 8 Section 9 Attachments Review/Submit

IHEG PY 2022 ( 1/1/2022 - 12/31/2022 ) IHP Amendment
SECTION 3: PROGRAM DESCRIPTIONS
[102(0)(2)(A)], [233(a)], [235(c)], [404(b)], 24 CFR §1000.512(b)(2) and (3)

In this section, the recipient must provide a description of its planned eligible activities, and intended outcomes and outputs for the One-Year IHP. The recipient can select any combination of activities
eligible under NAHASDA and intended outcomes and outputs that are based on local needs and priorities. There is no maximum or minimum number of eligible activities or intended outcomes and
outputs. Rather, the One-Year IHP should include a sufficient number of eligible activities and intended outcomes to fully describe any tasks that the recipient intends to fund in whole or in part with
IHBG resources during the coming program year.

Program Descriptions

Unique Identifier ~ | Program Name v | Eligible Activity “ | Intended outcome number v | Actual outcome number v
01 FCAS Operations and Maintenance (2) Operation of 1937 Act Housing [202(1)]  (6) Assist affordable housing for low incom...  (12) Other - must provide description in b... v
02 NAHASDA FCAS Operations and Mainten... (20} Operaticn and Maintenance of NAHA... (6] Assist affordable housing for low incom...  (3) Improve quality of substandard units v

Add New Program

Please correct data for program(s): FCAS Operations and Maintenance

Previous Section Save as Draft

9. Several of the fields will auto-populate from your IHP and will not be able to be edited. Your progress
for the program year should be included in Lines:

GEMS Grantee User Guide Version 1.22 pg. 36



e 1.5. Actual Outcome Number: Select an outcome from the dropdown that best fit the program.

e 1.8. APR: Describe Accomplishments: Describe what you were able to accomplish during the
program year.

e 1.10. APR Reason Behind Schedule: Include why the program is behind schedule, if
applicable.

e 1.9 APR Actual Number of Units Complete: Enter the number of IHBG-assisted units
completed, households served, and/or acres purchased for IHBG-assisted housing development
for each planned activity during the program year.

In the Uses of Funds table:

e Total IHBG (only) funds expended in 12-month program year (O): The amount of IHBG
funds spent for these activities in the program year.

e Total all other funds expended in 12-month program year (P): The amount of non-IHBG
funds spent for these activities in the program year.

= Note: This field no longer breaks down by type of other funds. Just enter the total dollar
amount on this screen. You will need to break it out further in Section 5.

*1.5. Actual Outcome Number @ --None--

* 1.6.Who Will Be Assisted @ 1

* 1.7. Types and Level of Assistance @ 1

1.8. APR: Describe Accomplishments @

1.10.APR Reason Behind Schedule @

1.9 Planned and Actual Outputs for 12-Month Program Year

* Planned Number of Units to be Completed in Year Under this 1
Program

* APR Actual Number of Units Complete ]

Complete this field.

Cancel Save as Draft Save and Continue

10. Click the Save and Continue button to return to the main Section 3 page. Verify that each of the added
programs are displayed and fix any error messages that appear under the Add New Program button.

11. Repeat Steps 8, 9, and 10 until you have entered information for all the programs that need be included
in the APR.
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12. Click the Next Section button to go to Section 5: Budgets.

- Section & Section 10 Section 11 Section 12 Section 13 Section 14 Attachments Review/Submit

IHBG PY 2021(10/1/2021 - 9/30/2022 ) Annual Performance Report (APR)

SECTION 5: BUDGETS
NAHASDA §§ 102(b)(2)(C), 404(b)

(1) Sources of Funding (NAHASDA § 102(b)(2)(C){), (404{b)} (Complete the nan-shaded partions of the chart below to describe your estimated or anticipated sources of funding for the 12-month program year. APR Actual
Sources of Funding -- Please complete the shaded portions of the chart below to describe your actual funds received. Only report on funds actually received and under a grant ag or other binding c
during the 12-month program year)

13. Complete Section 5 by updating the component as follows:
e Inthe (1) Sources of Funding table, enter the dollar amounts in Columns F, G, I, and K to report
the actual funds spent and unspent for each source in the program year. The system will calculate
Columns H and J in real time; they will be $0.00 until information is entered in Columns F, G, I,

F) @) () mn ) (K)
Actual
aArcnt;nJlert on .rﬁ\ec‘:t;ii[e.‘:\jmount total ﬁ:t:ﬂlj?dnds Actual unexpended Actual unexpended
‘ sources P funds remaining at funds obligated but not

It‘:zn;jnign of fﬂf:]rt]ﬁ 12- of ?nuc;'l]rt]ﬁ 12- end of 12- month expended at end of 12-

g g funding program year (H - 1) month program year
program year program year (F+G) program year

$0.00 $0.00 $0.00 $0.00 $0.00 $0.00

$0.00 $0.00 $0.00 $0.00 $0.00 $0.00

$0.00 $0.00 $0.00 $0.00 $0.00 $0.00

$0.00 $0.00 $0.00 $0.00 $0.00 $0.00

$0.00 - $0.00 $0.00 $0.00 $0.00

$0.00 - $0.00 $0.00 $0.00 $0.00

e Inthe (2) Uses of Funding table, check the information in Columns O and P for each of your
programs. These dollar amounts will auto-populate from Section 3. If you update any of these
cells, it will automatically update Section 3 as well. The system will calculate Column Q in real
time; it will be $0.00 until information is entered in Columns L and M.

0 GEMS might not show your programs in the order you expect, so check the program
name before entering any figures.
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(2) Uses of Funding (NAHASDA § 102(b}{2)(C)(ii)) {Note that the budget should not exceed the total funds on hand (Column C) and insert as many rows as needed to include all the programs identified in Section 3. Actual
expenditures in the APR section are for the 12-month program year.)

© (P) @
PROGRAM NAME
Total IHBG (only) funds expended in 12-month program year Total all other funds expended in 12-month program year Total funds expended in 12-month program year (O+P)
11 $0.00 $0.00 $0.00
$0.00 $0.00 $0.00
$0.00 $0.00 $0.00
$0.00 $0.00 $0.00

(3) Estimated Sources or Uses of Funding (NAHASDA § 102(b)(2)(C)).
* (Provide any additional information about the estimated sources or uses of funding, including leverage (if any). You must provide the relevant information for any planned loan repayment listed in the Uses of Funding table on the previous page. This

planned loan repayment can be associated with Title VI or with private or tribal funding that Is used for an eligible activity described in an IHP that has been determined to be in compliance by HUD. The text must describe which specific loan Is planned to
be repaid and the NAHASDA-eligible activity and program associated with this loan):

(4) APR (NAHASDA § 404(b))

* (Enter any additional information about the actual sources or uses of funding, including leverage (if any). You must provide the relevant information for any actual loan repayment listed in the Uses of Funding table on the previous page. The text must de-
scribe which loan was repaid and the NAHASDA-eligible activity and program associated with this loan.):

e Inthe (4) APR (NAHASDA 8 404(b)) text box, type in any applicable information. A description
for this text is included in GEMS.

14. Click the Next Section button to go to Section 6: Other Submission Items.

15. Complete Section 6 by answering Question 5 and any fields that may pop up based on your answer. All
other information on this page is loaded from your IHP, and you will not be able to make changes.
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Section 10 Section 11 Section 12 Section 13 Section 14 Attachments Review/Submit

IHBG PY 2021(10/1/2021 - 9/30/2022 ) Annual Performance Report (APR)
SECTION 6: OTHER SUBMISSION ITEMS

[102(b)(2)(C)Mii)], {201(b)(5)], [202(6)], [205(2)(2)], [209], 24 CFR §§ 1000.108, 1000.120, 1000.142,
1000.238, 1000.302

ion & Help

(1) Useful Life/Affordability Period(s) (NAHASDA § 205, 24 CFR § 1000.142) (Describe your plan or system for determining the useful life/affordability period of the housing it assists with IHBG and/or Title VI funds must be provided in the IHP. A record of
the current, specific useful life/affordability period for housing units assisted with IHBG and/or Title VI funds (excluding Mutual Help) must be maintained in the recipient’s files and available for review for the useful life/affordability period.):

b
* (2) Model Housing and Over-Income Activities NAHASDA § 202(6), 24 CFR § 1000.108) (If you wish to undertake a model housing activity or wish to serve non-low-income during the 12 h program year, those activities may be described
here, in the program description section of the 1-year plan, or as a separate submission.):
2

(3) Tribal and Gther Indian Preference [NAHASDA § 201(b)(5), 24 CFR § 1000.120) If preference will be given to tribal members or other Indian families, the preference policy must be described. This information may be provided here or in the
program description section of the 1-year plan.

* Does the Tribe have a preference policy?
Yes No

(4) Anticipated Planning and Administration Expenses (NAHASDA § 102(b)(2)(C}(if), 24 CFR § 1000.238)

Do you intend to exceed your allowable spending cap for Planning and Administration?
Yes No

(5) Actual Planning and Administration Expenses (NAHASDA § 102(b)(2)(C){i), 24 CFR § 1000.238)

" Did you exceed your spending cap for Planning and Administration?
[ ves [J No

Complete this field

If you did not receive approval for exceeding your spending cap on planning and administration costs, describe the reason(s) for exceeding the cap. (See Section &, Line 5 of the Guidance for Infarmation on carry-over of unspent planning and adminlstration
expenses.)

7~
* (6) Expanded Formula Area - Verification of Substantial Housing Services (24 CFR § 1000.302(3)) If your tribe has an expanded formula area (i.e., an area that was justified based on housing services provided rather than the list of areas defined in 24 CFR §
1000.302 Formula Area (1)), the tribe must demenstrate that it is continuing to provide substantial housing services to that expanded formula area. Does the tribe have an expanded formula area?
Yes No

If yes, list each separate geographic area that has been added to the Tribe's formula area and the documented number of Tribal members residing there.

For each separate formula area expansion, list the budgeted amount of IHBG and other funds to be provided to all American Indian and Alaska Native (AIAN) households and to only those AIAN households with incomes 80% of

medianincome or lower during the recipient’s 12-month program year.
Previous Section Save as Draft Next Section

16. Click the Next Section button to go to Section 10: Self-Monitoring.

Descriptions for this section are included in GEMS.

- Section 11 Section 12 Section 13 Section 14 Attachments Review/Submit

IHBG PY 2021 ( 10/1/2021 - $/30/2022 ) Annual Performance Report (APR)

SECTION 10: SELF-MONITORING
NAHASDA § 403(b), 24 CFR §§ 1000.26, 85.37, 85.40
*{1) Doyou have a procedure and/or policy for self-monitoring?
Yes
O No

Complete this field.

*{2) Pursuant to 24 CFR § 1000.502(b) where the recipient is a TDHE, did the TDHE provide periodic rts including the self-monitoring repert, Annual
Yes

O No
(O Mot Applicable
Complete this field.

Report, and audit reports to the Tribe?

*(3) Did you itoring, ub-recipients?

QO Yes

O No

Complete this field.

* (4] Self-Monitori . (Describe the resul itoring activities, includi ive actions planned or taken.)

Previous Section Save as Draft

18. Click the Next Section button to go to Section 11: Inspections.
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19. Complete Section 11 by updating the component as follows:

e Inthe (1) Inspection of Units table, enter the numbers by unit type in Columns B, C, D, and E.

The system will calculate Column F in real time; it will be O until information is entered in

Columns B, C, D, and E.

e For Question 2, answer the yes/no question and type in the text box, as applicable. Descriptions

for this section are included in GEMS.

- Section 12 Section 13 Section 14 Attachments Review/Submit

IHBG PY 2021 ( 10/1/2021 - 9/30/2022 ) Annual Performance Report (APR)

SECTION 11: INSPECTIONS
NAHASDA § 403(b)

(1) Inspection of Units (Use the table below to record the results of recurring inspections of assisted housing.)

Results of Inspections

Activity Total Number of Units Units in Standard Condition Units Needing Rehabilitation Units Needing to be Replaced Total Number of Units Inspected
) (8) © (D) (E) (F=C+D+E)

1937 Housing Act Units:

a. Rental 0 0 0 0 0
b. Homeownership 0 0 0 0 0
. Other 0 0 0 0 0
1937 Act Subtotal:

NAHASDA Associated Units:

a.Rental 0 ] ] 0 0
b. Homeownership 0 0 ] 0 0
c. Rental Assistance 0 0 0 0 0
d. Other 0 0 0 0 0
NAHASDA Act Subtotal:

Total:

* (2) Did you comply with your inspection policy:
Q Yes
O Mo

Complete this field

(3) If no, why not:

Y7

Previous Section Save as Draft Next Section

20. Click the Next Section button to go to Section 12: Audits.

21. Complete Section 12 by answering the yes/no question and selecting the date, as applicable.
Descriptions for this section are included in GEMS.
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IHBG PY 2021 ( 10/1/2021 - 9/30/2022 ) Annual Performance Report (APR)

SECTION 12: AUDITS

24 CFR § 1000.544

This section is used to indicate whether a financial audit based on the Single Audit Act and 2 CFR Part 200 Subpart Fis required, based on a review of your financial recards.
*Did you expend $750,000 or more in total Federal awards during the APR reporting period?

22. Click the Next Section button to go to Section 13: Public Availability.

23. Complete Section 13 by answering the yes/no questions and typing in the text boxes. Descriptions for

this section are included in GEMS.

IHBG PY 2021 (10/1/2021 - 9/30/2022 ) Annual Performance Report (APR)

SECTION 13: PUBLIC AVAILABILITY
NAHASDA § 408, 24 CFR § 1000.518

*(1). Did you make this APR available to the citizens in your jurisdiction before it was submitted to HUD (24 CFR § 1000.518)2

QO Yes
QO Ne

Complete this field.

*(2) If you are a TDHE, did you submit this APR to the Tribe(s) (24 CFR § 1000.512)?
QO Yes

QO No

O Not Applicable

Complete this field.

(3)1f you answered "No” to question #1 and/or #2, provide ion as to why nt and indicat

hen you will do so.

*(4) Summarize any comments received from the Tribe(s) and/or the citizens (NAHASDA § 404(d)).

Enter N/Af this is not applicable

24. Click the Next Section button to go to Section 14: Jobs Supported by NAHASDA.

25. Complete Section 14 by entering a number in Questions 1 and 2 and typing in the text box, as

applicable. Descriptions for this section are included in GEMS.

IHBG PY 2021(10/1/2021 - 9/30/2022) Annual Performance Report (APR)

SECTION 14: JOBS SUPPORTED BY NAHASDA
NAHASDA § 404{b)

Use the table below to record the number of jobs supported with IHBG funds each year.
Indian Housing Block Grant Assistance (IHBG)
* (1) Number of Permanent Jobs Supported

*(2) Number of Temporary Jabs Supported

(3) Narrative (optional):

4

Previous Section Save as Draft Next Section
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26. Click the Next Section button to go to the Attachments Section.

IHBG PY 2021 ( 10/1/2021 - $/30/2022 ) Annual Performance Report (APR)
Attachments

Attachment(0)

ViewAll

*Select a Document Type to attach to the form

GEMS Signature Attestation Page

27. Complete this section by uploading any attachments that need to be added to your APR. Click the
dropdown menu below Select a Document Type to attach to the form on the right-hand side of the
screen. The options are GEMS Signature Attestation Page, Tribal Certification Signature Page,
Delegation of Authority, Tribal Resolution, and Other. (Note: Forms requiring signatures can be found

under the Download Forms tab.)

o Please upload files individually. Your Grants Evaluation Specialist will verify that all sections
are complete and properly attached before moving your IHP to the next stage of the review
process.

e The GEMS Signature Attestation Page only needs to be completed once per person.

* Select a Document Type to attach to the form

FY

Please select... -

Please select...

GEMS Signature Attestation Page
Tribal Certification Signature Page
Delegation of Authority

Tribal Resolution H
Other

28. When you have selected the document type, you will have the option to find where the file is saved on

your computer (the Upload Files button) or drag and drop the file from a location that you can see.

L ) ) ) ) ) e ) )
IHBG PY 2021 ( 10/1/2021 - 9/30/2022 ) Annual Performance Report (APR)
Attachments

* Select a Document Type to attach to the form

Attachment(0) Other

2, UploadFiles Ordrop files here

ViewAll

Previous Section Save as Draft Next Section
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29. Ensure the file’s title and type are correct. Verify that your attachment was successfully uploaded.

Screen Shot 2021-03-18 at 5.49.46 PM
Mar 18,2021 o 53KB o
File Type: PNG
" Title: Screen Shot 2021-03-18 at 5.49.46 PM
Type: GEMS Signature Page

30. Click the Next Section button to go to the Review/Submit Confirmation section.

31. If the APP is complete, the section bar will be green and there will be a checkbox next to each of the
sections under Section Completion Status. Revisit any section that is not yet complete.

D I T Y S N R T Ry ey N
IHBG PY 2021 ( 10/1/2021 - 9/30/2022 ) Annual Performance Report (APR)

Review / Submit Confirmation

< The in is accurate activities o during the program y o utes and

Wan knawingly make a false statement on this form, you may be subject to civil or criminal penalties under Section 1001 of Title 18 of the United States Code. In additian, any persan who knowingly and materially violates any required
formaticn, including intentianal disclosure, is subject to a civil money penalty not to exceed $10,000 for each violation.

Title of Authorized APR Subrmitter

* APR Submission Date
1/12/2022

32. Once complete, your APR is ready to submit. As someone authorized to submit it, type their name twice
and then your title. Click the Submit button. You will receive a message that says your APR has been
submitted and is pending approval; you may wish to print this page for your records.

Congratulations! Your Annual Performance Report (APR) has been submitted to HUD but it is pending the appropriate Approving Official's wet signature(s). Please ensure the
Approving Official wet signature(s) is sent to HUD as soon as possible.

33. Click the Close button to return to the Home tab.

34. You can check the status of your APR from the Submissions tab. If no decision is shown, your area
ONAP office is still reviewing your submission.
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2020

2021

2021

2021

Submission Type

Interim Funding

Initial Plan (IHP)

APR Update

Initial Plan (IHP)

APR

Gr...

IHBG

IHBG

IHBG

IHBG

IHBG

Grant Number

55-1T-12345

55-1T-12345

55-1T-12345

55-1T-12345

55-1T-12345

Due Date

07/18/2019

07/20/2020

12/29/2021

Status

Submitted

Submitted

Submitted

Submitted

Submitted

Awards

Pending Tribal Certification

Download HUD Forms

Decision v

Not In Compliance

Recipient Program Year

10/1/2021 - 9/30/2022

10/1/2021 - 9/30/2022

10/1/2021 - 9/30/2022

10/1/2021 - 9/30/2022

10/1/2021 - 9/30/2022

Account...

HYTDHE

HYTDHE

HYTDHE

HYTDHE

HYTDHE

v

Edit

35. If you need to print your APR, see How to Print an IHP/APR.
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XI1.How to Update or Revise an APR

During your area ONAP office’s initial review, they may return your APR to you for revisions. If that is the
case, the instructions are the same as submitting the initial APR. Please see How to Complete an APR and start
with Step 4.

However, if your area ONAP office has completed their review and accepted your APR, and you need to update
or revise your APR further, please procced with the following steps.

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click the New Submissions tab.

Organizations New Submissions Submissions

2. Select the following options from the dropdown menus:
e Grant Program: Select IHBG
e Submission Type: Select Update Annual Performance Report
e Fiscal Year: Select the fiscal year for this report
e (1) Grant Number: Select the grant number for this report

New Submission - Select a submission you wish to complete

“Grant Program
IHBG

* Submission Type

Update Annual Performance Report

* Fiscal Year

2022

" (1) Grant Number :

551H3000680

3. Click the Next Section button in the bottom right-hand corner. The APR that you are amending will be
copied, and you will be able to make any necessary changes. While you do not need to make changes in
each section, you need to click through each section for the system to determine if the page is complete.

4. From this point, the instructions are the same as submitting the initial IHP. Please see How to Complete
an APR and start with Step 4.
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XIll. How to Print an IHP or APR

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click on either the Submissions

tab.

2. Locate the IHP or APR you need to print. You can narrow the records that show up by using the
submission display type dropdown search. Click the dropdown arrow at the end of the row and select

Compliance

Download Forms

Print.
Organizations New Submissions Submissions Awards
FY Submission Display Type n gram Grant Number

e select L 4 Please select Initial Plan (IHP) A 4 Please select v Please select v
FY ~ | Submission Type v | G.. v | GrantNumber ~ | P.~v | Status v | Dec... v
2019 Initial Plan (IHP) IHBG 551H0222220 Submitted In Com..
2020 Initial Plan (IHP) IHBG 55IH0222220 Submitted In Com..
2022 Initial Plan (IHP) IHBG 55IH0222220 Submitted In Com...
2023 Initial Plan (IHP) IHBG 55IH0222220 Submitted - Pe...

Reporting Periond End Date

Please select v

S.. ~ | RecipientP... v
1/1/2019-12/3..
1/1/2020-12/3..
1/1/2022-12/3..
1/1/2023-12/3...

Status

Please select

Accou...

Cedar Parl

Cedar Parl@.

Cedar Parkyl..

Cedar Pariy..

v

Recipient Reporting

v Please select

Repor... v

FS5-0056849 [ vJ

FS- Attach Forms
Documents
FS-

Print
FS-

3. Once the PDF is created, the IHP or APR will open in a new pop-up window. You can print and/or save
the file.

Section 1: Cover Page

Grant Number: 551H0222220

Recipient Program Year: 1/1/2019 - 12/31/2019

Federal Fiscal Year: 2019

Il nitial Plan (Complete this Section then proceed to Section 2)

[] Amended Plan (Complete this Section and Section 8 if applicable)
["]Annual Performance Report (Complete items 27-30 and proceed to Section 3)
[] Tribe

(8) [l TDHE

(9) Name of Recipient: Cedar Park TDHE

(10) Contact Person: Sarah Smith

(11) Telephone Number with Area Code (999) 999-9999: 111-222-3333
(12) Mailing Address: 13130 Texas 29

(13) City: Liberty Hill

(14) State: TX

(15) Zip Code (99999 or 99999-9999): 78642

(16) Fax Number with Area Code (999) 999-9999: 111-222-2333

(17) Email Address sfisher@cedar.org

(18) If TDHE, List Tribes Below:

[l Cedar Tribe A

Bl Ccdar Tribe B

)
2)
@)
)
)
(6)
)
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XIV. How to Complete an SF-425

If you need assistance with anything other than the SF-425 submission process in GEMS, please see Notice
PIH-2025-04 here: https://www.hud.gov/sites/dfilessfOCHCO/documents/2025-04pihn.pdf.

Unlike other reports you submit in GEMS, SF-425s are automatically generated by the system, and you can
view all scheduled reports for the year at any time. Before proceeding, ensure you are completing the correct
SF-425 by verifying the Reporting Period and Due Date. If you have any questions, please contact your Grants
Management Specialist or Grants Evaluation Specialist.

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click the Home tab.

2. Under My Tasks, locate the SF-425 you need to complete. You can narrow the tasks that show up by
using any of the following filters. With each dropdown you select, fewer items should appear on the list.
You can click Reset Filters, on the upper right-hand side of the screen, to show everything again:

e FY: Show all things submitted for a specific Fiscal Year

e Submission Display Type: Show all things by document type. Look for SF-425s by selecting
SF425 Report or SF425 Report (IHBG Formula)

e Grant Program: Show all things for a specific grant type

e Grant Number: Show all things for a specific grant

e Reporting Period End Date: Show all things with a specific end date for the reporting period

3. When you locate the SF-425 that you want to submit, click the dropdown arrow at the end of the row
and select Edit to open the SF-425 page.

My Tasks ResetFilters  Create New Submission
Version FY Submission Display Type Grant Program Grant Number Reporting Periond End Date Due Date Status Recipient Reporting Year
Please select v Please select v Please select v Please select v Please select v Please select v Please select v Please select v Please select v

Version Vv FY v | Submission Type v | G.. v | GrantNum... v PeriodEnd... v | DueDate v | Status v Recipient Program Year v | Accou... v
1 2023 SF425 Report (IHBG Formula Read-only) IHBG 551H123456 03/31/2023 05/01/2023 Pending Submission 1/1/2023 - 12/31/2023 HYTDHE v
1 2023 SF425 Report (IHBG Formula Read-only) IHBG 55IH123456 06/30/2023 07/31/2023 Pending Submission 1/1/2023 - 12/31/2023 HY  View

Edit
1 2023 SF425 Report (IHBG Formula Read-only) IHBG 551H123456 09/30/2023 10/30/2023 Pending Submission 1/1/2023 - 12/31/2023 HY" '

Print
1 2023 SF425 Report (IHBG Formula) IHBG 551H123456 12/31/2023 04/01/2024 Pending Submission 1/1/2023 - 12/31/2023 HY”

4. Several of the fields will auto-populate with your organization’s information and will not be able to be
edited. Your figures for the reporting period should be included in the following lines. All required
fields are indicated with an *. GEMS will do the line math, but it is not completed in real time. The
fields you can update are:

e 5. Recipient Account # or Identifying #
e 6c. Final Report

e 7. Basis of Accounting

e 10a. Cash Receipts Cumulative
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e 10b. Cash Disbursements Cumulative

e 10d. Total Federal Funds Authorized

e 10e. Federal Share of Expenditures

e 10f. Federal Share Unliquidated Obligation

e 10i. Total recipient share required

e 10j. Recipient share of expenditures

e 10l. Total Federal program income earned

e 10n. Program income — additional alternative
e 12a. Current Investment Balance (available only on IHBG formula grants)
e 12. Remarks: Enter any explanations

e 13a(i). Name of Authorized Official

e 13a(ii). Title of Authorized Official

e 13b. Signature of Authorized Official

e 13c. Telephone with Area Code

e 13. Email Address

Information

Status Grant
Pending Submission 55IH123456
Due Date Version
5/1/2023 1

Required Submission Review Decision

Required Submission-002818

Fiscal Year Submission Type

2023 SF425 Report (IHBG Formula Read-only)
1. Federal Agency@ ONAP Account

Alaska HYTDHE

2. Federal Grant or Identifying Number@ 5. Recipient Account # or Identifying # @
551H123456

3(a). Recipient Organization@ 6a. Report Type @

HYTDHE Quarterly

Cancel

5. Click the Save button in the bottom right-hand corner, you will be returned to the My Tasks Page

6. Now click the dropdown arrow at the end of the row and select View to open the expanded SF-425 page.
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My Tasks

Version FY Submission Display Type

Please select v Please select v Please select

Version Vv FY v | Submission Type

1 2023 SF425 Report (IHBG Formula Read-only)
1 2023 SF425 Report (IHBG Formula Read-only)
1 2023 SF425 Report (IHBG Formula Read-only)
1 2023 SF425 Report (IHBG Formula)

v

Reset Filters Create New Submission

Grant Program Grant Number Reporting Periond End Date Due Date Status Recipient Reporting Year

Please select v Please select v Please select v Please select v Please select v Please select v

v | G.. v | GrantNum... v PeriodEnd... v | DueDate v | Status v Recipient Program Year v | Accou... v
IHBG 551H123456 03/31/2023 05/01/2023 Pending Submission 1/1/2023 - 12/31/2023
IHBG 55IH123456 06/30/2023 07/31/2023 Pending Submission 1/1/2023 - 12/31/2023 - View
Edit
IHBG 551H123456 09/30/2023 10/30/2023 Pending Submission 1/1/2023 - 12/31/2023 HY" '
Print
IHBG 551H123456 12/31/2023 04/01/2024 Pending Submission 1/1/2023 - 12/31/2023

7. 'You can now review what you entered on the previous screen and add indirect expenses, investment
information, notes, and attachments, if applicable. Depending on your screen resolution, the sections to
add indirect expenses, investment information, notes, and attachments will either be on the right-hand

side of the screen (as shown in th

e screenshot below) or at the bottom of the page.

If you need to change any of the information from the previous screen, you can click the Edit

button at the top right-hand corner or double click on the field that you need to edit. Be sure to
click the Save button at the bottom of the screen when you are done.

GEMS Required Submission . )

Required Submission-002821 Edit | Submit
v Information = a Indirect Expenses (0) New
Status Grant
Pending Submission 551H123456
Due Date Version Investments (o) New
4/1/2024 1
Required Submission Review Decision
Required Submission-002821 Notes & Attachments (0) Upload Files
Fiscal Year Submission Type
2023 SF425 Report (IHBG Formula)

&, UploadFiles

1. Federal Agency@ ONAP Account
Alaska HYTDHE Or drop files
2. Federal Grant or Identifying Number@ 5. Recipient Account # or Identifying #@

If your organization uses indirect
Click the New button in the Indir
required; they are:

e a. Type

e Db. Rate

e . Period From

e d. Base

e e. Amount Charged
o f. Federal Share
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New Indirect Expenses

Information
Indirect Expenses ID *SF425 Report
Required Submission-000184 X
*a.Type @ *d.Base @
*b.Rate @ *e.Amount Charged @

*f.Federal Share @

Cancel Save & New

9. Click the Save button to return to the main page or click the Save & New button to add another indirect
expense (repeat Step 7). The expense will appear in the Indirect Expenses box and total on the form.
e If you need to edit an expense, click the dropdown arrow at the end of the row that you need to
edit, and select Edit to reopen the Indirect Expenses page.
e If you need to delete an expense, click the dropdown arrow at the end of the row that you need to
delete, and select Delete.

10. Repeat Steps 7 and 8 until you have entered all indirect expenses.

11. If your organization has investment authority and this is your IHBG formula grant’s SF-425, you need to
add this information. If not, skip to Step 13. Click the New button in the Investments box and add the
necessary data. The following fields should be used when new funds are drawn down from eLOCCS
and invested. The investment worksheet or other routine reporting methods you use to report interest,
etc., should be added as an attachment:

e Draw Down Type

e Amount Drawn Down

e Date of Draw Down

e Date Funds Drawn Down were Invested
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New Investment

Information

Investments ID *SF425 Report

Required Submission-000244 X

*Draw Down Type @ *Date of Draw Down @

:[3

* Amount Drawn Down @ * Date Funds Drawn Down were Invested @

Cancel Save & New

12. Click the Save button to return to the main page or click the Save & New button to add another
investment (repeat Step 10). The investment will appear in the Investments box and total on the form.
e If you need to edit an investment, click the dropdown arrow at the end of the row that you need
to edit, and select Edit to reopen the Investments page.
e If you need to delete an investment, click the dropdown arrow at the end of the row that you need
to delete, and select Delete.

13. Repeat Steps 10 and 11 until you have entered all new investments.

14. If you need to add any notes and/or attachments, you will have the option to add them in the Notes &
Attachments box. If not, skip to Step 15. You can find where the file is saved on your computer (either
of the Upload Files button) or drag and drop the file from a location that you can see.

15. When the file uploads, click on the Done button to return to the SF-425. The attachment will appear in
the Notes & Attachments box.
e Click the View All link in the box if you need to make a change. Each file will be listed, and you
can do the following steps by clicking the dropdown arrow at the end of the row for each file.
When you are done, Use the internet browser’s back button to return to the form.
o Download
View File Details
Upload New Version
Edit File Details
Delete

O 0O o0 o

16. Click the Submit button in the upper right-hand corner.

e If your organization has investment authority and this is your IHBG formula grant’s SF-425, you
will receive the following pop up message if there is nothing in 12a (Current Investment
Balance). If that is correct, click the Yes button. Otherwise, click the No button and enter your
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investment balance in the required field. When it has been submitted, a green success banner will
appear for a moment at the top of the screen.

Confirmation

Current Investment Balance is zero. Please
update the amount if you have an investment
balance.

Are you sure you want to submit?

e For all other SF-425s, you will receive the following pop up message. Click the Yes button to
submit the SF-425, or click the No button to go back and look at and/or make changes before
submitting. When it has been submitted, a green success banner will appear for a moment at the
top of the screen.

Confirmation

Are you sure you want to submit?

17. You can check the status of your SF-425 from the Submissions tab. If no decision is shown, your area
ONAP office is still reviewing your submission.

Home Organizations NOFA New Submissions Submissions
lersion FY Submission Display Type Grant Program Grant Number
Please select v Please select v Please select v Please select v Please select
El FY ~ | Submission Type v | G.. v | GrantNumber ~ | PeriodEnd... v
i 2022 SF425 Report (IHBG Formula Read-only) IHBG 55IH0222220 12/31/2022
s 2023 SF425 Report (IHBG Formula Read-only) IHBG 55IH0222220 03/31/2023
i 2023 SF425 Report (IHBG Formula Read-only) IHBG 55IH0222220 06/30/2023
i 2023 SF425 Report (IHBG Formula Read-only) IHBG 55IH0222220 09/30/2023
is 2023 SF425 Report (IHBG Formula Read-only) IHBG 55IH0222220 12/31/2023
2019 Initial Plan (IHP) IHBG 55IH0222220

Awards

Reporting Periond End Date

v

Status

Submitted

Submitted

Submitted

Submitted

Submitted

Submitted

Compliance

Please select

v

Decision v

Accepted

Accepted

In Compliance

Case Download Forms
Status Recipient Reporting Yeail

v Please select v Please select
Submit Date v | Recipient Program Year
02/01/2023 1/1/2022 - 12/31/2022
02/01/2023 1/1/2023 - 12/31/2023
02/01/2023 1/1/2023 - 12/31/2023
02/01/2023 1/1/2023 - 12/31/2023
02/02/2023 1/1/2023 - 12/31/2023
1/1/2019 - 12/31/2019
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18. If you need to print your SF-425, see How to Print an SF-425.
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XV.How to Update or Revise an SF-425

Once an SF-425 is submitted, you cannot update or revise it without taking additional steps. These vary
depending on where it is in the review status and if you or your area ONAP office request a revision.

An update or revision can be needed or requested:
a) after you have submitted the SF-425 but before your area ONAP office has reviewed it,
b) during your area ONAP office’s reviews, or
c) after your area ONAP office’s review is complete.

You Notice an Error Before the Area ONAP Office has Reviewed the SF-425

If you notice something that needs to be changed before your area ONAP office has reviewed it, send an
email to your Grants Management Specialist or Grants Evaluation Specialist to have the SF-425 returned.

Once returned, the SF-425 can be found on your Home tab; return to How to Complete an SF-425 to
resubmit your SF-425.

Area ONAP Office Requests Changes During Review

If your area ONAP office has questions during the review process, they will email you and, if needed, return
the SF-425 for revisions.

Once returned, the SF-425 can be found on your Home tab; return to How to Complete an SF-425 to
resubmit your SF-425.

You Notice an Error After the Area ONAP Office has Reviewed the SF-425

Once an SF-425 has been accepted, if you notice something needs to be changed take following steps:
1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click on the Submissions tab.

2. Locate the SF-425 you need to edit. You can narrow the tasks that show up by using any of the
following filters. With each thing you select, fewer items should appear on the list. Click Reset
Filters, on the upper right-hand side of the screen, to show everything again:

a. FY: Show all things submitted for a specific Fiscal Year.

b. Submission Display Type: Show all things by document type. Look for SF-425s by selecting
SF425 Report or SF425 Report (IHBG Formula).

c. Grant Program: Show all things for a specific grant type.

d. Grant Number: Show all things for a specific grant.

e. Reporting Period End Date: Show all things with a specific end date for the reporting period.
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3. When you locate the SF-425 that you want to edit, click the dropdown arrow at the end of the row
and select Create New Version.

New Submissions Submissions Awards Compliance

Organizations

FY Submission Display Type Grant Program Grant Number Reporting Periond End Date Status
e select v Please select v Please select v Please select v Please select v Please select v Please select v
FY v | Submission Type v | G.. v | GrantNumber ~ | PeriodEnd... v | Status v | Decision v | SubmitDate v |Rwv
2022 SF425 Report (IHBG Formula Read-only)  IHBG 551H0222220 12/31/2022 Submitted Accepted 02/01/2023 1/1.
2023 SF425 Report (IHBG Formula Read-only)  IHBG 55I1H0222220 03/31/2023 Submitted Accepted 02/01/2023 1/1.
2023 SF425 Report (IHBG Formula Read-only) IHBG 55IH0222220 06/30/2023 Submitted 02/01/2023 1/1..
2023 SF425 Report (IHBG Formula Read-only) IHBG 55IH0222220 09/30/2023 Submitted 02/01/2023 1/1..
2023 SF425 Report (IHBG Formula Read-only) IHBG 55IH0222220 12/31/2023 Submitted 02/02/2023 1/1..

Download Forms

Recipient Reporting Year

Please select

v

Ced...
( View

Create New Version
(

Print
(

4. The new SF-425 will pop up on the screen. Scroll down and click the Save button. The new version

will be visible on your Home tab.

5. Return to How to Complete an SF-425 to resubmit your SF-425 and start with Step 4.
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XVI. How to Print an SF-425

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click on either the Home tab or
the Submissions tab.

2. Locate the SF-425 you need to print. You can narrow the tasks that show up by using any of the
following filters. With each thing you select, fewer items should appear on the list. Click Reset Filters,
on the upper right-hand side of the screen, to show everything again:

a. FY: Show all things submitted for a specific Fiscal Year.

b. Submission Display Type: Show all things by document type. Look for SF-425s by selecting
SF425 Report or SF425 Report (IHBG Formula).

c. Grant Program: Show all things for a specific grant type.
Grant Number: Show all things for a specific grant.

e. Reporting Period End Date: Show all things with a specific end date for the reporting period.

3. When you locate the SF-425 that you want to print, click the dropdown arrow at the end of the row, and
select Print.

My Tasks Resct Filters Create New Submission
Version FY Submission Display Type Grant Program Grant Number Reporting Periond End Date Due Date Status Recipient Reporting Year
Please select v Please select v Please select v Please select v Please select v Please select v Please select v Please select v Please select v

Version v FY v Submission Type v Gr.. v Grant Number v PeriodEnd... Vv Due Date v Status v Recipient Program Year v

A

1 2023 SF425 Report (IHBG Formula) IHBG 55IH123456 06/30/2023 07/31/2023 Pending Submission 1/1/2023 - 12/31/2023 HETL View
1 2023 SFA25 Report (IHBG Formula) IHBG 551H123456 09/30/2023 10/30/2023 Not Started 1/1/2023 - 12/31/2023 H
H

1 2023 SF425 Report (IHBG Formula) IHBG 551H123456 12/31/2023 04/01/2024 Not Started 1/1/2023 - 12/31/2023

Success!

Select the "View" menu, for this report, to access the generated SF425 PDF from the "Notes & Attachments" table.

4. Because the file takes a moment to generate, the SF-425 will be available in the Notes and Attachments
list on the SF-425 record. Locate the SF-425 again, click the dropdown arrow at the end of the row, and
select View.
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Create New Version

v

v

Organizations New Submissions Submissions Compliance Download Forms
FY Submission Display Type Grant Program Grant Number Reporting Periond End Date Status Recipient Reporting Year
e select v Please select v Please select v Please select v Please select v Please select v Please select v Please select
FY s~ | Submission Type v | G.. v | GrantNumber s | PeriodEnd... v | Status v | Decision w | SubmitDate v |Rv |Av |R.
2022 SF425 Report (IHBG Formula Read-only) IHBG 551H0222220 12/31/2022 Submitted Accepted 02/01/2023 /1.
2023 SF425 Report (IHBG Formula Read-only) IHBG 551H0222220 03/31/2023 Submitted Accepted 02/01/2023 1/1... ¢ View
2023 SF425 Report (IHBG Formula Read-only) IHBG 55IH0222220 06/30/2023 Submitted 02/01/2023 /1.
Print
2023 SF425 Report (IHBG Formula Read-only) IHBG 551H0222220 09/30/2023 Submitted 02/01/2023 1/1... ¢
2023 SF425 Report (IHBG Formula Read-only) IHBG 55IH0222220 12/31/2023 Submitted 02/02/2023 1/1... Ced..

0385... A

5. When the screen refreshes, scroll to the Notes and Attachments section. Find and click on the PDF that

you just created; it is likely the first link. If you do not see it, click View All.

6b. Period
a

Notes & Attachments (6+)

6c. Final Report@

v

GEMS_SF425_Report S...
May 10,2023  Attachm...

7. Basis of Accounting@
Cash

Eepor,

8a. Project/Grant Period From@ M 10’ 2023 - A h_
ay 10, e Attachm...

1/1/2022

GEMS_SF425_Report_S...
Feb 28,2023 » Attachme...

8b. Project/Grant Period To)
12/31/2022

9. Report Period Start Date
10/1/2022

9. Report Period End Date@
12/31/2022

Upload Files
GEMS_Email_Grantee S...
May 10,2023  Attachm...

GEMS_Email_Grantee_S...
May 10,2023  Attachm...

GEMS_Email_Grantee_S...
Feb 28,2023 o Attachme...

View All

6. When the screen refreshes, the PDF will open, and you can print and/or save

the file.

GEMS - U.S. Department of Housing and Urban Development (HUD)

Grant Program : IHBG

Fiscal Year : 2023

Program Year : 55IH123456

Name of Recipient : HYTDHE

Report: SF425 Report (IHBG Formula)

Grantee Information
Federal Agency and Organizational Element to Which Report is Submitted Alaska
Federal Grant or Other Identifying Number Assigned by Federal Agency 551H123456
3(a). Recipient Organization HYTDHE
3(b). Address 11760 Baltimore Avenue
3(c). City Beltsville
3(d). State MD
3(e). Zip Code 20705
4(a). UEI Number
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XVII. How to View Your Organization’s Contacts

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click on the Organizations tab.

Make sure that the list view you are looking at is the My Organizations list. If you do not see My
Organizations next to the buildings in the blue square on the left-hand side of the screen, you can
change your view by clicking on the downward arrow and selecting My Organizations. If you are with a

TDHE, you will see the Tribe and your organization.

E Accounts
@ My Organizations

3items e Sorted by Account Name e Filtered bAll accounts - Is My Organization e Updated 2

Account Name T ~ | Mailing Street

1 Cedar Park TDHE 3450 East Whitestone Boulevard

Search this list...

~ | Mailing City v

Cedar Park

Recipient Program ...

01/01-12/31

- -

Account

TDHE

2. Click on your organization’s name in the Account Name column to view the information about your

organization and the users associated with it.

Account

L&) Cedar Park TDHE

Grantee Type GEMS Grantee ID

0207236

Tax Identification Number
TDHE 111111111

Recipient Program Year
01/01-12/31

Please contact your area ONAP representative if any of the contacts displayed is not correct.

v Account Information

Account Name Account Record Type

Cedar Park TDHE TDHE

Parent Account ONAP Region

Phone
512-111-1111

E Contacts (5)

ContactNa... Title

Peter King Chief

Email

pking@cedar

Phone

3. Depending on your screen resolution, the Contacts box will either be on the right-hand side of the screen
(as shown in the screenshot above) or at the bottom of the page. Click on an individual’s hame to view
the user’s information, including if they are the executive contact, if their account is active, and if their
wet signature is on file. Contact your Grants Management Specialist or Grants Evaluation Specialist if

any of the information is incorrect.

Mr. Frank D Manning

v Signature Confirmation

GEMS Wet Signature on File/Verified@
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XVIII.  How to Submit and Watch a Support Case

Support for GEMS is provided by multiple ONAP staff. You may get a faster response by submitting a help
ticket or support case instead of contacting one ONAP staff member directly.

After logging in (Step 1), please continue to the subsection that applies.

1. Once logged-in to GEMS (see How to Login to Your GEMS Account), click on the Case tab.

Awards Compliance Case Download Forms

New Submissions Submissions

Submit a New Support Case

2. Click the New button in the right-hand side of the screen.

Download Forms

ome rganizations issions ards ase
= Cases
- My Cases v # Printable \§ew New >
« Sorted by Priority » Filtered by M Se this list W Ee & =
Case Num... v | ContactNa... »  Subject v | Status | Priority T v | Date/Time Opened v | Case Owner Alias v
00001044 Sarah Teste: Help with IHP Section 5 New Medium 1/3/2023 12:40 PM stest v
00001058 Sarah Tester How can | add attachments to SF425 New Medium 4/7/2023 2:41 PM stest v

Enter information about your question and/or the issue that you are experiencing. Be sure the Status of
your case is New. Click the Save button to submit your support case to ONAP, or click the Save & New

button to submit and create another support case (repeat Step 2)

New Case: GEMS Crantee Support Case

Case Information

Case Number * Status
New v
Account Name Priority
Medium
Contact Name ONAP Region
* Case Reason
IHP A

Grant Program

Cancel Save & New

Available
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See the Status of My Support Cases

2. Ensure that the list view you are looking at is the My Cases list. If you do not see My Cases next to the
briefcase in the orange square on the left-hand side of the screen, you can change your view by clicking
on the downward arrow and selecting My Cases. This will show all the support cases that you have
submitted in the system.

3. Click on the case number in the Case Number column to view the details, status, and/or response from

ONAP staff.

a. An ONAP staff member may reach out to you outside of GEMS to get additional information

and/or troubleshoot the problem you are experiencing.

Organizations

New Submissions

Submissions

Awards

Compliance

‘. Cases
e My Cases v

00001044

2 00001058

Sarah Tester

Sarah Tester

2 items  Sorted by Priority e Filtered by My cases » Updated a few seconds ago

Case Number v | ContactNa... v | Subject

Help with IHP Section 5

How can | add attachments to SF425

v | Status

New

New

~ | Priority 1
Medium

Medium

Search this list... q

v | Date/Time Opened v

1/3/2023 12:40 PM

4/7/2023 2:41 PM

Medium New

ase N

00001044

Cedar Park TDHE

Help with IHP Section 5

Case
E Help with IHP Section 5

Nu
00001044

New
riority
Medium

512-111-1111

bresentative will be displayec

s from your local area

ONAP
1 here.

Attachments (0)

&

O

Upload Files

drop files
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